Dungeon Architect for Unity

Getting Started

Create your first Dungeon
Install Dungeon Architect

Install and import Dungeon Architect from the Asset Store. You should
see the following folders:

@ Assets

JungeonArchitect
e DungeonArchi aunchPad
e DungeonArchitect_Samples

Setup Dungeon Prefab

Create a new Scene

Navigate to CodeRespawn > DungeonArchitect > Prefabs and
drop in the DungeonGrid prefab on to the scene
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Select the dungeon game object and inspect the properties. We’ll
need to assign a new theme before we can build the dungeon
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Assign Theme

Assign an existing theme to the dungeon actor

* Navigate to Assets\DungeonArchitect Samples\Demo Theme Candy\Themes
* Assign theme file named CandyDungeonTheme as shown in the
image below

Element O @ L CandyDungeonThe| @
&3 DungeonArchitect_Samples
- N ———
L CandyDungeonTheme

" 5 oemo_Theme_conds

== Themes




Build Dungeon

Select the DungeonGrid game object and click the Build Dungeon
button in the Inspector window

v = ¥ Dungeon (Script) il - 8
Script Dungeon @
¥ Dungeon Themes
Size 11 |
Element 0 EEanerungennTheme {Grad @

Debug Draw -
|[ Build Dungeaon

Cestroy Dungeaon

—

Randomize Dungeon

Select the DungeonGrid game object and change the Seed value in
the configuration. Changing this value will create a dungeon with a
different layout

¥ @«  Grid Dungeon Config (Script) il +
Core Config
seed (12345 [~ ]
Num Cells 1100 I

Click Build Dungeon button to rebuild the dungeon with the new
seed



Organization

All the dungeon objects are created on the root hierarchy and makes
it difficult to organize. We’ll configure it so all objects are spawned
under a certain game object
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Lets destroy this current dungeon, configure it for better organization
and then rebuild
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Figure 1: Create an empty game object

Destroy Existing Dungeon Search for dungeon on the hierarchy
search box

¥ Unity 2019.1.0f2 Personal - Tutorial_01A.unity - DA19.1_dev - PC, Mac & Linux Stan

File Edit Assets GameObject Component Dungeon Architect Window |

N ¢ EIEAINIRIES

i= Hierarchy
| Create T| “rdungean

€} Tutorial_01A——

Select the DungeonGrid game object and click the Destroy Dungeon
button

Clear out the search text box in the hierarchy. Your hierarchy should
now look like this
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Configure Parent Object Create an empty Game Object. All our
dungeon items will go inside this parent object

Rename the parent object (e.g. Dungeon Items)
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Select

the parent object and Reset the transform

8 Inspector ## Scene

0 ¥ [Dungeon Items | [] static =
Tag [Untagged  #| Layer [Default ¢
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Select the parent object and set it to static



8 Inspector

9 ¥ [Dungeon Items || & static Iv

Tag | Untagged  #|Layer |Default 4|

Assign the parent object to the GridDungeon game object
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Rebuild Dungeon Select the GridDungeon game object and click
Build Dungeon

All your dungeon game objects will be organized under the parent
object



| K
|

= Hierarchy =
| Create 7| (crall
v € Tutorial_01A* -
L __Main Camera
b 4 DungeonGrid »
. Directional Light

¥ Dungeon Items

'

Design your first Theme

A theme file is a mapping between marker names (like Walls, Ground,
Door etc) and the meshes that you provide. The prefabs you map
here will be used to build your dungeon

In the previous section, we created a dungeon with an existing
theme file (CandyDungeonTheme). In this section, we’ll create one
ourselves

Create a Theme File

Create a new theme file from either the Main menu or the Create
menu

This will create a theme file in the current open directory in the
Projects window
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Figure 2: Create from Main menu
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Figure 3: Create from Create menu
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Open the Theme File

Double-click the theme file to open the Theme Editor. Dock the
theme editor so you can see both the Scene view and the Theme
Editor at the same time

### Assign the Theme File

Destroy the existing dungeon by selecting DungeonGrid game object
and click Destroy Dungeon button

Assign the theme file that you just created, on to the DungeonGrid
game object
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3 Project

Click Build Dungeon and nothing should appear. That’s because we
haven’t added prefab mappings on the theme yet

Design the Theme

Navigate to Assets\DungeonArchitect Samples\Demo Theme Candy\Prefabs.
This folder contains a set of mesh prefabs we can use for our dungeon
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» 5 Demo_Theme_Outdoorcl]
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» &l DemoBuilder_GridFlow
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Add Ground Drag-drop the ground prefab mesh on to the Theme

Editor
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Ground

Link up the mesh node with the Ground marker node. When you do,
you should see a live preview on the scene view with the dungeon
using this ground mesh
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For the live preview to work, make sure the “Realtime Update” button
is enabled in the Theme Editor

Dungeon Theme

eTo> Tools> Realtime Update Visualize Markers

Ground

Another criteria for the live preview to work is that a dungeon in the
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scene should reference the theme that is currently being edited in
the theme editor

Adjust Object Transform Dungeon Architect can adapt to any
modular asset. In our example, the dungeon’s grid size is set to (4,
2, 4). The ground prefab that we used has the same size (4x4) and
the pivot is in the center. So it will fit nicely without any change

Dungeon Themes
Size
Element O CandyDungeonTheme (Graph)
Debug Draw
Build Dungeon

Destray Dungean

Help / Support
M Discord Support B Documentation

Launch Pad

Mum Cells

Grid Cell Size

Cell Dimensions
Min Cell Size
Max Cell Size

Room Area Threshold
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However, this might not always be the case. Your prefabs might have
its pivot in a different position (like in the corner) and the size may
be different than the grid size we’ve defined in the dungeon game
object.

Here’s an example of a modular ground prefab from one of the Synty
asset.
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The Pivot is in the corner and the size of the tile is 5x5 units

If we were to drop this in the theme editor and link it to the ground
marker, we’d see this
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The tiles overlap since the asset is bigger than the grid size (we chose
the grid size to be 4 and the asset size is 5)

Select the mesh node and set the scale to 0.8 (since 4/5 = 0.8)
HE i N
port B Documentation @
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Now we need to align the position. Click Visualize Markers from
the theme editor’s toolbar

Ground Wa WallSeparator

Select the ground prefab node or the Ground marker node to visualize
the correct position of where your meshes should be
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Use a corner as a reference for alignment, like in the image above

We’ll move it along X by -2 and see where it goes
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That doesn’t seem right
rectly along the x-axis

. Move the X along 2 instead and it fits cor-
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Move along Z by 2 units to bring it to the correct position
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Marker Visualizer Aswe’ve seen in the previous section, the theme
editor’s Marker Visualizer is a useful feature while designing your
dungeons. It will show the alignment guides whenever you select a
built-in marker node (like Ground, Wall etc) or any node connected
underneath it

Turn it on from the Theme Editor’s toolbar and select a built-in marker
node or any node underneath it to visualize that marker’s expected
alignment

ols * Realtime Update Visualize Markers
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Wall
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Add More Prefabs Go ahead and add prefabs under the following
markers: Wall, Fence and Door

Add Wall Pillars Drag drop the Pillar2 prefab to the theme editor
and link it to the WallSeparator marker node
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Theme
] "| Toals ~|

Ground WallSeparator

We’ll need to make this pillar a bit bigger. Select the node you just
dropped and modify the Scale parameter under Offset category
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Inspector i

MeshMode_b0ad581d-d1a6-46f4-992f-fh534[@ 5 #,

Realtime Update

Game Object Node

Template [Pillarz o]
Is Static [«
Affects Navigation ™

Offset

Position ¥ [0 ¥ilo Z: o
Rotation 0 Yio0 Z: 0
Scale i i 1.05 212
Attachment

Probability {1

Consume On Attach

Add Windows We have two wall meshes in the samples folder

Walll Wallz2

The other one (Wall2) has a window. Lets configure the theme to
sometimes use this second mesh so we have windows

Drag drop Wall2 prefab on to the theme editor and place it before
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(left of) the existing wall prefab node

When you connect this to the Wall marker node, you’ll notice it has
picked up the window node for all the walls
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wall

This is because Dungeon Architect starts executing the nodes from
left to right. When the condition was satisfied to pick the first node,
it stopped execution and never came to the second node.

There are multiple ways you can control this condition, the simplest
being adjusting the probablity of selection.
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Figure 4: Half the walls have windows

Select the node you just dropped and change the probability to 0.5
(this would mean it gets selected 50% of the time). The other 50% of
the time, it would not be selected and the execution would then move
to the next node, and hence selecting the non-windowed wall node

© Inspector [
MeshMNode_038f43cd-aaSe-4800-a3[@ 5 #

Realtime Update

Game Object Node

Template [wwallz o]
Is Static [
Affects Navigation [«

Offset

Fosition i 0 ¥i|o Z2i|o
Rotation i 0 ¥i|o Zi|o
Scale Wil O Zi 1

Attach i .

Probability 0.5 |

| 1
onsume On Attach [

Add Wall Decorations There’s a photo frame prefab we’d like to
attach to every wall
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Drag drop this prefab to the theme editor before the two existing
nodes and link it to the Wall marker node

This will cause all the walls to disappear and be replaced with this
photo frame

This is because once the photo frame was selected, the execution
stopped and the the wall nodes further down the line were not exe-
cuted.
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Select the photo frame and uncheck the flag “Consume on Attach”.
This will cause the execution to continue further even though this
node was selected by the theming engine

© Inspector
MeshNode_af080ced-7352-4be0-9dg

Game Object Node

Templats [ PhetaFrame
Is Static

Affects Navigation (¥

offset

Posiion X0 |vio  |Zi[0
Rotation  X: 0 o |z
Scale o PR Jz:[T

Attachment

Probabilit 1
Consume On Attach [J
Rules

[ Selection Rule Nene (Mono
[J Transform Rule None (Mana

Lets adjust the offset of the photo frame (position and rotation) to
make it properly align with the inner walls

Select the photo frame node and change the position to (0, 2, -
0.22) and rotation to (0, 180, 0)

Affects Navigation [«

Offset

Position X
Rotation X
Scale X

=}
=
Fa
I~

1-0.22

¢ 180

=]
<
o

,_.
=
o
N
o

Attachment Y

Probability |1
Consume On Attach [

The photo frame is aligned with the walls
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Marker Emitters We have an issue with the photo frames. They
also spawn near windows

Marker Emitters allow you to emit marker names from any of your
dropped prefab nodes. This means, we can define a new marker node
(e.g. MyWallDeco) and then emit that marker from the wall node that
doesn’t have a window (Walll prefab). All our wall decorations can
now go under this MyWallDeco marker and it will show up only near
solid walls

Right click on an empty area in the theme editor and select Add
Marker Node

Add Game Object Node
Add Game Object Array Node

Add Sprite Node
Add Marker Node
Add Comment Mode
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Select the node and change its name to MyWallDeco

== B Inspector
E MarkerMNode_817e783a-f2a4-41

Marker Node

MName MyWallDeco

Break the link to the photo frame

realtime

RIGHT CLICK
TO BREAK LINK

Connect this under MyWallDeco marker node. All the future wall
decorations can also go under this marker
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Now emit this marker from the wall node that doesn’t contain a
window

Drag a link out of the bottom of the solid wall prefab node and release
the mouse in an empty area

Wall

Add Marker Emitter: Door
Add Marker Emitter: Fence

Add Marker Emitter: FenceSeparator
Add Marker Emitter: Ground

Add Marker Emitter: MyWallDeco

A vima r o e
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You can follow the same method to create another type of decoration
(e.g. MyWindowDeco) and emit it from under the windowed wall node
In this example, I've added a flower pot in the windows
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MeshNode_66448ef4-84a2 @ 5 #

Game Object Node

Template | FlowerPot e
Is Static *4
Affects Navigation [

Offset

Position  X: 0.4 Y175 [Z2:0
Rotation  X: 0 i o z:
Scale x: g Z:[0.3

Attachment

Probability B

Consume On Attach (W

Rules
[ Selection Rule ~ None @
[] Transform Rule = None | @

SpatialConstraint
Use Spatial Constr_|

Recap In this section we learnt the following:

* Probablity - Controls the percentage chance of a node being
selected. A value of 1 means 100% selection chance. A value of
0.25 means 25% selection chance

* Execution Order - The theme engine executes all the nodes
under a marker node from left to right. If it selects a certain
node, it stops executing, unless the Consume on Attach flag is
unchecked

* Marker Emitters - You can create complex hierarchies with your
own marker nodes, giving you more freedom to decorate your
dungeons

Launch Pad Window

Use the Launch Pad window to setup new dungeon scenes, browse
the samples, clone from templates and much more

Open Launch Pad

From the Main menu, open the Launch Pad window Dungeon Archi-
tect > Launch Pad
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- Tutonal_02.unity - DA19.1_dev - PC, Mac & Linux Standalone™

bject Component Dungeon Architect  Window Help

[ |E§§ 4 | E Create »

Windows ¥

Launch Pad 2

Navigation

Select the various sections from the left.

Dungeon Architect - Laun...

CUNGEON ARCHITECT - LAUNCH PAD

Flow Graph Templates

Theme Templates 3D Templates

“Umentation : e

Tutorials 3 ok By 5

Support Grid Flow Builder Snap Bu

Use the navigation bar on the top to go back to a previous page.
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Dungean Architect - Laun...

DUNGEOMN ARCHITECT - LAUN

Builder Templates

Figure 5: Navigation bar

This is useful for retaining the scroll positions of the previous page
(especially for larger pages like the Samples section)

Builder Templates

Dungeon Architect supports many different types of dungeon layout
methods and is designed in a way that new layout methods can be
easily added in the future

These layout methods are called Dungeon Builders or Builders in
short

This section lets you create a new scene preconfigured with one of
the builder templates. Click on any of the builders. In the next screen,
click the Clone Scene button
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DungeonArchitect-Laun., O e =0

Builder Templates

Mario Builder Circular City
[lir 3 g ular city b

Spatial Partition Floor Planner

Build a dungeon using plans.

Figure 6: Dungeon Architect - List of Builders
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DUNGECN ARCHITECT - LAUNCH PAD

Builder Templates
Samples

Fl raph Tem
Theme Templ

Documentation

Grid Flow Builder

or hat

This will create a new scene based on the template, fully configured
with the appropriate dungeon. It will also clone a starting theme file
(and any other flow graph assets) and set everything up.

Choose a folder to saved your scene file. Once saved, the launcher
would do the following:

* Open the new scene

* Open any theme editor windows associated with the referenced
assets (Theme Editor, Flow Graph Editors etc)

* Select the dungeon game object (so you see the properties in
the inspector by default)
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Samples

BL Templa
Samples

Flow Graph Termpla
Theme Temp

umentation runtime. Play anc

Outdoor Cliffs
Cliff t i i g Runtirr
i C S r.l-l’.

There are tons of samples to explore. Select a sample you like and
perform one of the following actions

*« Open Scene: Opens the sample scene (usually under Dun-
geonArchitect Samples folder)

* Open Folder: Opens the folder containing the scene

* Clone Scene: Clone a scene and also clone over the referenced
assets (themes, flow graphs etc) so you can modify them without
affecting the sample scene

¢« Watch Demo: Watch a video, if it exists
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Mario Demo Game

—
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Flow Graph Templates

Flow Graph Templat

Therme Templ:

nentation

Flow graphs allow you to control the flow of your dungeon (more on
this in the later tutorial sections). This section contains a list of flow
graph templates you can use as a starting point for your project

Theme Templates

Clone one of the many themes and use it in your project or as a
starting point for a new theme

Select a theme and clone it
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Builder Templa
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Flow Graph Templa

Theme Templates PRSI e ﬁ gﬁ m . .

b ok
a0

GridFlow Template - Default

with various branches, treasure, enemies

der Templa
ples
Flow Graph Templa

Theme Temp

apFlow Template - Default

Figure 8: Clone Snap Flow Graphs
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DUNMGED

h Templates Candy Default

Theme Templ

umenta

Outdoor Hills Simple (White)

Mario Default

Figure 9: Theme template browser
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DUNGEQOIN CHITECT - LAUNCH PAD

= Templa

Sampl

Sraph Templa

Theme Temp

S
-

Rocky Caves

Clone Theme

There’s also a category on External Themes, the ones that use exter-
nal paid art assets from the Asset Store. You can use these themes if
you also own the art asset.
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ARCHITECT - LAUNCH PAD

Theme Temp
1ient
Moba (Summer) Moba (Winter)
rt

Graveyard Multi-Story

TopDown Wood TopDown Stone TaD Sewers

—

Moba (Summer)
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Documentation

Links to various online documentation, including this one

DUNGEON ARCHITECT - LAUNCH PAD

w online

umentation i
Tutorials |

rt

Support

Reach the developers through any one of these channels. Interact
with the community and the devs in Discord chat and forums or reach
directly through email

Builder Templates

N

Theme Templa

Discord Chat Email support

mentation

News

Dungeon Architect News! Find out whats new since the last update
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DUNGEON ARCHITECT - LAUNCH PAD

Builder Templates
les

Flow Graph Templa

Theme Templates

&0 @

New GridFlow Builder
Design and control the flo d which this

Grid Flow Builder

Create a Grid Flow Dungeon

The Grid Flow Builder offers a rich set of tools to control the flow of
your dungeons and item placement

Setup Dungeon Prefab

Create a new scene. Navigate to Assets/DungeonArchitect/Prefabs
and drop in the DungeonGridFlow prefab on to the scene
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= Hierarch

'l ungeonArchitect * Prefabs >

DungeonGridFlow

Prefabs

Select the DungeonGridFlow game object you just dropped and reset
the transform
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© Inspector |

a ' DungeonGridFlow | [+ Static ¥
Tag |Untagged ¢ Layer |Defaule  ¢]
Prefab | Open | Select | |Overrides - |

Setup Parent Object

Create a new Parent object where all the spawned dungeon items
will go in.

i= Hierarchy

W Cungeon Items

Reset the parent object’s transform and set it to static

& Inspector

G ¥ Dungeon Items | o Static
Tag Untagged ¢ Layer [Defaur ¢

Assign the parent object
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= Hierarchy 8 Inspector

This makes sure all the spawned dungeon objects are placed under
this parent object

Setup Theme

There’s a theme available in the samples folder which we’ll use for
this tutorial section

Navigate to Assets\DungeonArchitect Samples\DemoBuilder GridFlow\Theme
and assign the theme ThemePrehistoric to the DungeonGridFlow
game object
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%= Hierarchy

™ D idFlow | ¥ Static «

Tag | Untagged ¢) Layer [Defaule |
Prefab [ Open [ Select | i

2 Project

== Theme

Setup GridFlow Graph

This builder requires another asset called the Grid Flow Graph. This
is a graph that helps you control the flow of your dungeon. In this
section, we’ll use an existing graph from the samples folder

Navigate to Assets\DungeonArchitect Samples\DemoBuilder GridFlow\FlowGraph
and assign the graph DemoGridFlow to the DungeonGridFlow game
object’s Flow Asset property
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Figure 10: GridFlow dungeon built using the Prehistoric theme

= Hierarchy @ Inspector
| c’!:t!QﬂUntit‘I}:‘:I‘l‘ — ¥ DungeonGridFlow | ¢ Static ¥
[\)Main Camera Tag | Untagged 4| Layer | Default ™|
 Directional Light Prefab | Open | select | [oOwerides -]
* DungeonGridFlow ¥ .~ Transform QS
|, Dungeon Items Position xo ¥o z[o
Rotation X0 Yo Z0
Scale ¥l 1 Z1
¥ « ¥ Dungeon (Script) e
Script Dungeon o]
¥ Dungeon Themes
i3 Project Size |L = = |
|creater] @ g | k| Element 0 EThemePrehlstorlc (Grapl @
viEaAssets 4 feeete— Dungeond chiy| Debug Draw g
&3l DungeonArchitect [ Build Dungean ]
) &l DungeonArchitect_LaunchPad \[ Destroy Dungeon ]
¥ G5 DungeonArchitect_Samples
» 5 Demo_LandscapeTransformer ¥ =~ Grid Flow Dungeon Config (Scrif S

» 5 Demo_SpatialConstraints
» &5 Demo_Theme_Candy
» G5l Demo_Theme_OutdoorCliffs

GridFlowDungeonConfig o]
11 |
0

Mode 2D

bﬁDemn_Thl:me_S.imTleShapes Flow Asset ED:moGridFlow (Dungeor| ©
Pﬁ DemnBu! er_CircularCity Grid Size )(|4 |Y|4 |Z|4 |
» &5 DemoBuilder_FloorPlanner

¥ &5 DemoBuilder_GridFlow ¥ @ Grid Flow Dungeon Builder (Scri i

» G Art
== FlowGraph
> & Scenes
» &8 Scripts
&5 Theme

Async Building

Asynec Build L
Max Build Time Per F32 |
Async Build Start PosNone (Transform)

b S MamnaRuiildar GridFlaw?n

Build Dungeon

Select the DungeonGridFlow game object and click Build Dungeon

button from the inspector window
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Figure 11: GridFlow dungeons support key-locks

Open Grid Flow Editor

Let’s open the GridFlow asset in the editor:

Navigate to Assets\DungeonArchitect Samples\DemoBuilder GridFlow\FlowGraph
and double click on DemoGridFlow.

Dock the editor window so you see both the scene view and the grid
flow editor

Click the Build button on the top left of the flow editor to build a new
dungeon in the Grid Flow Editor
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Link Editor with Dungeon

We are going to link up the dungeon we have on the scene
(DungeonGridFlow game object) with the Grid Flow Editor so when
we generate a new dungeon in the editor, it syncs up the dungeon on
the scene

Click an empty space (grey area) in the Execution Graph

This will show up the execution graph properties in the Inspector
window
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e Inspector =
HHI @ = %

Linked Dungeon

Dungeon Object ‘Mone (Grid Flow Dungeon Builder ©

Preview Settings
Randomize Seed [+
Seed 1081479835

Figure 13: Execution Graph properties

Assign the dungeon game object by dragging the DungeonGridFlow
over

1 + BIEEIGIE | o) =R ) e

ne | €Game & Assetstore > 0 insp: a=
KA IEED

Now build the dungeon again by clicking the Build button in the
Execution Graph Window
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o Game See Grid Flow Editor

b Build S

Execution Graph

Create Grid

This will recreate the dungeon in the scene view. The dungeon in the

editor window is now synchronized with the dungeon in the scene
view

If you double click on any of the tiles in the Tilemap window, the
scene view should focus on that tile/item

Double click on the Bonus Item (B) in the tilemap.

62



Figure 14: Select a node to preview the build process

Explore Grid Flow Graph

After you’'ve built a dungeon in the editor (by hitting the build button
on the top left), you can select each node and see how the dungeon
layout was built, as shown in the lower preview panels

Design a Grid Flow Graph

In the previous section, we used an existing Grid Flow graph. In this
section, we’ll design one ourselves.

Setup

Destroy the existing dungeon and clear out the Flow Asset that we
assigned earlier

Create a new Grid Flow asset from either the Create menu or the
Main Menu

Rename to something appropriate and double click the grid flow asset
to open it in the editor

We won’t be needing the scene view for some time. Dock the editor
so we have more working area
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¥ = [+ Dungeon (Script) [ = %
Script Dungean i

¥ Dungeon Themes
Size 1 |
Element 0 @ThemePrehisi o
Debug Draw ]

[ Build Dungeon ]
[ Cestroy Dungeaon ]
¥ «  Grid Flow Dungeon C i«
Script GridFlowDunge @
| Seed 308346483 |
Mode 2D -
| Flow Asset |None (Dungeon| 1!
Grid Size

X4 It 4 |2 [a |

Figure 15: DungeonGridFlow game object properties

Folder

Tutorial_Dungeon
C# Script
Shader

Create

Show in Explorer Testing

Open Playables »

Delete Assembly Definition
Rename Assembly Definition Reference
Copy Path Alt+ Ctrl+C TextMeshPro >

jpan Feara e Dungeon Architect > Dungeon Theme
View in Package Manager =g S Buldey ’
Post-processing Profile Grid Flow Builder > Grid Flow Graph
lopzrl e Prefab Variant Snap Grid Flow Builder >
Import Package >
Audio Mixer Landscape

Export Package...

Find References In Scene Material

LT SR . o

Figure 16: Create Menu
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CUEUL LT FEMSUNdE S UALLS
wols Teols  Dungecn Architect Window  Help

Create * Dungeon Theme

Launch Pad Snap Builder

Grid Flow Builder
Snap Grid Flow Builder

Landscape

Notice that there is only one node in the Execution graph, the Result
node. Our final output should be connected to this node

Create Grid

Right click on an empty area in the Execution Graph and from the
context menu select Layout Graph > Create Grid
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Layout Graph Create Grid
Tilerap Create Main Path

Result Create Path
Add Comment Node Spawn ltems
Create Key Lock

Finalize Graph

E @ 3 .

Create Grid

Description
Grid Info

Resolution

Create Grid %[5 v 5

Connect this node to the Result node and hit build

Create Grid

Result

Grid Flow Editor

2cution Graph

Create Grid
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This node creates an initial grid to work with

Result: Layout Graph

In this builder, you first design your level in an abstract layout graph
like this and then move the final result to a tilemap
Create Main Path

We’ll next create a main path within this grid. The main path has a
spawn point and goal

Create a new node Layout Graph > Create Math Path
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Layout Graph Create Grid
Tilemap Create Main Path
Result Create Path

Spawn [tems

Add Comment Node
Create Key Lock

Finalize Graph

Unlink the Create Grid node from the Result node (do this by right
clicking on the node’s orange border)

Create Grid Create Main Path

RIGHT CLICK
TO UNLINK

Result

Link the nodes up like below and click Build

Create Grid —_— Create Main Path

Result

This node creates a main path in the grid. Keep clicking the build
button for different result
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If you do not see random results when you click build, make sure
randomize is enabled. Enable this by clicking on an empty area in
the Execution Graph to show the properties. In the inspector, select
Randomize Seed

Select the Create Main Path node and inspect the properties
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We’ll leave everything to default for now

Notice the Path Name parameter is set to main This is the name of
the path and we will be referencing this path in the future nodes with
this name

You can adjust the size of the path. Start Marker Name and Goal
Marker Name lets you specify a name for the markers. You can then
create these markers in the theme file and add any object you like. In
the Prehistoric theme, there’s a marker already created with these
names and a player controller is placed under SpawnPoint marker
and a level goal handler prefab is placed under LevelGoal marker
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SpawnPoint

Create Alternate Path

We’ll next create an alternate path pathing off the main path so the
player has another way of reaching the goal

Create a new node Layout Graph > Create Path

Layout Graph Create Grid
Tilemap Create Main Path
Result Create Path
Spawn ltems

Add Comment Mode
Create Key Lock

Finalize Graph

Connect the nodes together like below
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Create Grid ———i Create Main Path —_— Create Path

v

Result

Leave all the properties as default and click build

Select the Create Path node and inspect the properties
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Change the Path Name from path to alt. We will be referencing this
path as alt in the future

You can specify the paths from which this path should start and end.
The Start From Path parameter is set to main, referencing the main
path we created in the previous section

The End On Path is left empty, so the end of this path doesn’t connect
back to anything. We’d like this path to connect back to the main
path.
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Set the End On Path parameter to main

Parameter | Value Min Path Size | 3 Max Path Size | 3 Path Name
| alt Node Color | orange Start From Path | main End On Path |
main

This will make the alternate path (orange) connect back to the main
path (green)
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Keep clicking build for different results
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Create Treasure Room (Main)

We’ll add a treasure room connected to the main path

Add a new node Layout Graph > Create Path and set it up as fol-
lows:

Create Grid ————  Create Main Path —p Create Path
Alternate Path

Result
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Parameter | Value Min Path Size | 1 Max Path Size | 3 Path Name
| treasure main Node Color | yellow Start From Path | main End
On Path | main
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Create Treasure Room (Alt)

We’ll add another treasure room connected to the alt path but keep
the End On Path parameter empty so it doesn’t connect back to any-
thing:

Add a new node Layout Graph > Create Path and set it up as fol-
lows:

Create Grid | ————  Create Main Path

Result
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Create Path

Description Treasure (alt)
Path Info

Min Path Size 1

Max Path Size 1

Fath Mame treasure_alt
Mode Color | | #
Branching Info

Start From Path alt

End On Path

Advanced

Draw Debug -

Parameter | Value Min Path Size | 1 Max Path Size | 1 Path Name
| treasure_alt Node Color | yellow Start From Path | alt End On
Path |
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Create Key Room

We’ll create a room connected to the main path which will act as the
key room. We’ll later configure this room to have a key that opens
up a lock in the main path. It will also have a NPC (key guardian)
guarding the key

Add a new node Layout Graph > Create Path and set it up as fol-
lows:

Create Grid — Create Main Path e

Result

Create Path

Description Key Room
Path Info

Min Path Size 1

Max Path Size 1

Fath Mame key_room
MNode Color [ | F
Branching Info

Start From Path main

End On Path

Advanced

Draw Debug ]

Parameter | Value Min Path Size | 1 Max Path Size | 1 Path Name |
key room Node Color | cyan Start From Path | main End On Path
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We’ve named this path key room. It will be referenced later on when
creating the key locks

Create Key-Lock (Main)

We’ll next create a key-lock system on the main path. Our key will
go on the Key Room we created earlier (key room path) and the lock
will be somewhere in the main branch (main path)

Add a new node Layout Graph > Create Key Lock and set it up as
follows:
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Layout Graph Create Grid
Tilemap Create Main Path

Result Create Path

Add Comment Mode Spawn ltems

Create Key Lock
Finalize Graph

Create Grid | —#  Create Main Path ‘ re ith Create Path
an. K

Create Key Lock
Main branch
Result

Create Key Lock

Description Main branch

Branch Info

Key Branch key_room
Lock Branch main

Marker HNames

Key Marker Name KeyMain
Lock Marker Name LockMain

Key Placement

Flacement Method | Randem Tile
Avoid Placing Next To [«

ar

Paramter | Value Key Branch | key room Lock Branch | main Key
Marker Name | KeyMain Lock Marker Name | LockMain
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Specify the Key Branch as key room and Lock Branch as main

Set marker name for the key as KeyMain and lock as LockMain. Then
in the theme file, you’d create marker nodes with these names and
add your key and locked gate prefabs.

The prehistoric theme already has these setup
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LockMain

i

Create Key-Lock (Treasure Main)

We need a key-lock to guard the treasure room in the main branch

Add a new node Layout Graph > Create Key Lock and set it up as
follows:

Create Grid = —p  Create Main Path = —p

Create Key Lock
Wain branch

Result

Create Key Lock

Description Treasure (Main)

Branch Info

Key Branch main

Lock Branch treasure_main

Marker Names

Key Marker Name KeyTreasure

Lock Marker Name LockTreasure

Key Placement
Flacement Method | Randam Tile
Avoid Placing Next To [«

ar
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Parameter | Value Key Branch | main Lock Branch | treasure main
Key Marker Name | KeyTreasure Lock Marker Name | LockTrea-

sure

Set marker name for the key as KeyTreasure and lock as LockTrea-
sure. Then in the theme file, you’'d create marker nodes with these
names and add your key and locked gate prefabs.

The prehistoric theme already has these setup
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##+# Spawn Enemies
(Main, Alt)

We’ll use the Spawn Items node to spawn enemies on the main and
alt paths

Create a new node Layout Graph > Spawn Items and set it up as
follows:

Layout Graph Create Grid

Tilemap Create Main Path

Result Create Path

Add Comment Node Sl B
Create Key Lock
Finalize Graph

Create Grid ~ —#  Create Main Path - 2 Path 7 ?—ti:‘-‘

Result
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Parameter | Value Paths | main, alt Item Type | Enemy Marker
Name | Grunt Min Count | 1 Max Count | 5
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This will spawn enemies in the nodes, gradually increasing the number
of enemies based on the difficulty. The difficulty increases as we
get closer to the goal. You can control this from the Spawn Method
properties. Leave it to default for now

We’ve specified the marker name as Grunt and an appropriate marker
node should be created in the theme file so we can spawn prefabs
under it. The pre-historic theme already has this marker

Grunt

88



You can control the placement of items (in the tilemap) from the
Placement Method property section. Leave it to default for now

Spawn Bonus (Treasure Chests)

Spawn treasure chests in your bonus rooms using the Spawn Items
node

Create a new node Layout Graph > Spawn Items and set it up as
follows:

Create Grid  —#  Create Main Path = —p=  Create Pﬁ::l Create Pf’f" » Create Path Create Path

Alterna Main) Treasure (alt) K n

\

Create Key Lock Create Key Lock
Spawn Items ] i Ly | ‘ & ey |
o s Treasure (Main) WMain branch

Result

Spawn Items

Description Spawn Treasure

Spawn Info

¥ Paths
Size 2
Elerment 0 treasure_main
Element 1 treasure_alt
Item Type | Bonus $ |
Marker Name Treasure
Min Count 1
Max Count 1

Spawn Method

Spawn Method | Linear Difficulty
Spawn Distribution Va 0.2

Min Spawn Difficulty 0

Spawn Probability 1

an

Placement Method
Flacement Method | Random Tile
Avaid Placing Next To [«

an

Debug Info
Shaow Difficulty -

Parameter | Value Paths | treasure main, treasure alt Item Type |
Bonus Marker Name | Treasure Min Count | 1 Max Count | 1 Min
Spawn Difficulty | 1
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We’ve specified the marker name as Treasure and an appropriate
marker node should be created in the theme file so we can spawn
prefabs the treasure chest under it. The pre-historic theme already
has this marker

Treasure

'

The Min Spawn Difficulty is set to 1. The first node in the branch
will have a difficulty of 0 and the last node 1. Sometimes, the yellow
branch may be 3 nodes long. Since we want the chest to occur only
on the last node, we’ve set this value to 1
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Spawn Key Guardian

We’ll add an NPC in the Key room guarding the key

Create a new node Layout Graph > Spawn Items and set it up as
follows:

Create Grid = —  Create Main Path d ath Create Path »  Create Path

Result

Spawn Items

Description Key Guardian

Spawn Info

¥ Paths
Size 1
Element 0 key_room
Item Type | Enemy + ]
Marker Name KeyGuardian
Min Count 1
Max Count 1

Spawn Method

Spawn Method | Linzar Difficulty
Spawn Distribution v 0.2

Min Spawn Difficulty 0

Spawn Probability |1

a

Placement Method

Placement Method | Random Tile
Avoid Placing Next Tiw]

Debug Info

Show Difficulty -

ar

Parameter | Value Paths | key room Item Type | Enemy Marker
Name | KeyGuardian Min Count | 1 Max Count | 1
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You'll need to create a marker named KeyGuardian in the theme file
and place your NPC prefab under it. This marker doesn’t exist in the
Prehistoric theme and you’ll need to create it yourself if you want
to visualize it

Spawn Health Pack

We’ll use the Spawn Items node to spawn a few health pickups along
the main and alt paths

This section also shows you how to use the Custom Item Type

Create a new node Layout Graph > Spawn Items and set it up as
follows:

Create Grid | —#  Create Main Path

Result
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Parameter | Value Paths | main, alt Item Type | Custom Marker
Name | HealthPickup Min Count | 0 Max Count | 1 Spawn Proba-
bility | 0.5 Custom Item Info > Item Type | health pickup Custom
Item Info > Text | Health Custom Item Info > Text Color | [Red]
Custom Item Info > Background Color | [White]
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:::note You'll need to create a marker named HealthPickup in your
theme file and add your health pack prefab :::

Finalize Layout Graph

After we are done designing the layout graph, we’ll need to finalize it
with the Finalize Graph node. This node does a few things:

¢ Move the locks from the nodes on to the links
* Create one way doors (so we don’t go around locked doors)
¢ Assign room types (Room, Corridor, Cave)

Create a new node Layout Graph > Finalize Graph and set it up
as follows:
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Layout Graph
Tilemap
Result

Add Comment Mode

Spawn Items
Health Pack

\

Finalize Graph

Spawn Items

[

—>

Leave all the properties to default
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Create Grid
Create Main Path
Create Path
Spawn ltems
Create Key Lock
Finalize Graph

Spawn Item
Spawn Treasur

.‘_

Guardian

Result
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We are now ready to create a tilemap from this

Initialize Tilemap

Create a new node Tilemap > Initialize Tilemap and set it up as
follows:

Layout Graph
Tilemap Initialize Tilernap
Result Create Tilemap Elevations

Add Comment Node Create Tilemap Overlay
Merge Tilemaps

Optimize Tilemap

Finalize Tilemap
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Health Pack

\
A

A/

Finalize Graph —_— Initialize Tilemap

Result

Initialize Tilemap

Description

Layout Settings

Tilemap Size Per Node 10
Perturb Amount

Corridor Lane Width z
Layout Padding

Cave Settings

Cave Thickness 2.25
Cave Automata Meighbors |5

Cave Automata Iterations 4

Color Settings

Room Color Saturation 0.3
Room Color Brightness 1.5

You can control the thickness of the caves from the Cave Thickness
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parameter. Each node on the layout graph gets converted into rooms
in the tilemap.

The parameter Tilemap Size Per Node controls how many tiles are
used to generate a room from the node. Bump this number up if you
want more space in your rooms

If you want a more uniform grid like look on your rooms, bring the
Perturb Amount close to 0

Layout Padding adds extra tiles around the dungeon layout. Set to
5 so we can apply some decorations outside the dungeon bounds

When you select a node on the layout graph, the tiles that belong to the
node light up. This is controlled by the Color Settings parameters

Add Background Elevation

We are going to create overlays and merge them with the original
tilemap. Create the following two nodes:

¢ Create a node Tilemap > Create Tilemap Elevations
* Create a node Tilemap > Merge Tilemaps

Layout Graph

Tilemap Initialize Tilerap

Result Create Tilemap Elevations
Create Tilemap Overlay

Add Comment Node
Merge Tilernaps

Optirnize Tilemap

Finalize Tilemap
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Layout Graph

Tilemap Initialize Tilerap

Result Create Tilemap Elevations

Add Comment Node Create Tilemap Overlay

Merge Tilernaps
Optimize Tilemap

Finalize Tilemap

Link them up like below:
A

alize Graph — Initialize Tilemap === ————————————» Merge Tilemaps — Result

Ly

T~a

Create Tilemap Elevations

Update the properties

Parameter | Value Noise Frequency | 0.1 Num Steps | 8 Min Height
| 0.5 Max Height | 3.5 Sea Level | -1

We’ve specified the marker name as Rock. If you place objects under
the specified marker node in the theme editor, they will show up on
these tiles at the given height

The Min/Max height is logical and will be mulitplied by the dungeon
config’s Grid Size Y value. If the GridSize is (4, 2, 4) in the Dun-
geonGridFlow game object’s config and the tile height happens to be
2.5, the actual placement willbe on 2.5 * 2 = 5

Add Tree Overlays

We’ll overlay trees on our dungeon using a noise parameter. These
overlays will be placed such that they will not block the main path

Create a node Tilemap > Create Tilemap Overlay
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Figure 18: Create Tilemap Elevation properties
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Figure 19: Create Tilemap Elevation Node Result
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E Graph — Initialize Tilemap —_— — - ) Merge Tilemaps ——p=  Result

e

Create Tilemap Elevations
R

Create Tilemap Overlay
Add Trees

Figure 20: Create Tilemap Overlay Node Connection

Layout Graph

Tilemap Initialize Tilernap

Result Create Tilemap Elevations

Add Comment Node Create Tilemap Overlay
Merge Tilemaps
Optimize Tilemap

Finalize Tilemap

Noise Settings

Parameter | Value Noise Frequency | 0.2 Noise Max Value | 1.5 Noise
Threshold | 0.75 Min Dist From Main Path | 1

Merge Config
Parameter | Value Max Height | 1

Finalize Tilemap

Finalize the tilemap to complete the grid flow graph

Create a node Tilemap > Finalize Tilemap
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Create Tilemap Overlay

Description Add Trees
Marker Name Tree
Color — ¢

Generation Settings
Generation Method [ Moise 4]
¥ MNoise Settings
Noise Octaves 4
Noise Frequency 0.2
Noise Value Power 0
Noise Min Walue 0
Noise Max Value 1.5
Noise Threshold |0.75
Min Dist From Mair 1
Overlay Blocks Tile [+
Merge Settings
¥ Merge Config
Min Height 0
Max Height 4
Wall Overlay Rule| Keep Wall Remove Overt |
Marker Height offs0 |
Marker Height Offs 0
Remove Elevation[ |

Figure 21: Create Tilemap Overlay Node properties

Figure 22: Result of the Create Tilemap Overlay Node
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Figure 23: Merged result

Layout Graph

Tilemap Initialize Tilemap

Result Create Tilemap Elevations

Add Comment Node Create Tilemap Overlay
Merge Tileraps
Optimize Tilemap

Finalize Tilemap

Merge Tilemaps — Finalize Tilemap — Result

v x
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Finalize Tilemap node places all the items on to the tilemap (enemies,
keys, bonus etc)

Build Dungeon

Assign this grid flow graph to your DungeonGridFlow game object
and click Build Dungeon

106



7 = ¥ Dungeon (Script) il = 8

Script Dungeon o]
¥ Dungeon Themes
Size 1 |
Element O EThemePrehisturic (Graph) | (o]
Debug Draw [

[ Build Dungean ]

[ Destroy Dungean ]

¥ @« Grid Flow Dungeon Config (Script) o
Secript GridFlowDungeonCanfig o]
Seed [1 |
Mode 2D -

Flow Asset |§TutﬂridFlnw {DungennGridFlnwAssl
Grid Size

Optimize Tilemap

When the tilemap based level is generated, there are many tiles that
the player might never see, as they are far away from the dungeon
layout
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The Optimize Tilemap removes tiles that are away from the specified

distance from the dungeon layout bounds

Create a node Tilemap > Optimize

Layout Graph
Tilemap
Result

Add Comment Mode

Connect it before the Finalize Tilemap node like below:

—»  Finalize Tilemap ——| oOptimize Tilemap |—» Result
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Tilemap

Initialize Tilernap

Create Tilemap Elevations
Create Tilemap Owerlay
Merge Tilernaps
Optimize Tilemap

Finalize Tilemap




Figure 24: Optimize Tilemap Node Result
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Figure 25: Optimize Tilemap Before / After
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Figure 26: Optimize Tilemap Before / After

Optimize Tilemap

Description | |

Discard distant background tiles

Discard Distance Fro|4 |

Rebuild the dungeon in the scene view

Key Lock System

The spawned Key and Lock game objects will have the following
components attached to it by Dungeon Architect
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T

Explores Fog Of War[ |

/

¥ o4 Grid Flow Door Key Compone R
Seript - GridFlowDoorkeyCompe @
Key Id
¥ Valid Lock Ids
Size
Element 0

¥ Lock Refs
Size

Element 0 - Doorlargelocked_Red (| @

be

¥op Grid Flow Item Metadata Con

Script |« GridFlowltemMetadataC| @
Itern Type
Itern Id 1odeabdl-44f9-4395-8704-27

> Referenced Item Ids

Figure 27: New Components attached to the Key Prefab

KoTare
Tint

Fog o
Explor

1con L
f War
es Fog Of War[_|

¥ o4 Grid Flow Door Lock Compon a ¥

Seript | GridFlowDaorLockComp| ©
Lock Id '4b140082-c857-4cdc-aaaf-35|
¥ Valid Key Ids
Size 1 |
Element 0 |1e4e4bd1-44f9-4395-8704-27
YVa\id'Ke\r Refs
Size fL |
Element 0 [ KeySkull_Red (GridFlon| @

¥ o4 Grid Flow Ttem Metadata Con bl <

Script |+ GridFlowItemMetadatacC| @
Item Type [ Lock 4]
Itern Id [4b140082-c857-4cdc-aaaf-35]

|» Referenced Item Ids

v o
Script

Dungeon Scene Provider Dat 2
| - DungeanScencProviderl @

Figure 28: New Components attached to the Locked Door Prefab
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Key Component

The builder will attach a new component GridFlowDoorKeyComponent
to the spawned key prefab

¥ ¢4 Grid Flow Door Key Component (Script) ﬁ il s 8
Script GridFlowDoorkKeyComponent (o]
Key Id lodedbdl-44f9-4395-8704-27d3077594el

¥ Valid Lock Ids

Size 1
Elerment O 4b140082-c857-4cdc-aaaf-3552b2bd7cc2
¥ Lock Refs
Size 1
Element 0 DoorLargeLocked _Red (GridFlowDoorLoy @

This component contains the Keyld and a reference to all the locks
that this key can open

Parameter | Value Key Id | The Key Id Valid Lock Ids | List of Lock
Ids that can be opened by this key Lock Refs | References to the
spawned lock game objects that can be opened by this key

Lock Component

The builder will attach a new component GridFlowDoorLockCompo-
nent to the spawned lock prefab

¥ ¢ Grid Flow Door Lock Component (Script) Q@ = &,
Script GridFlowDoorLock Component @
Lock Id 4b140082-c857-4cdec-aaaf-3552b2bd 7oc2
¥ alid Key Ids
Size 1
Elerment O lcdedbdl-44f9-4395-8704-27d3077594el
¥ Valid Key Refs
Size 1
Element O Keyskull_Red (GridFlowDoorKeyCompaor @

This component contains the LockId and a reference to all the keys
that open this lock

Parameter | Value Lock Id | The Lock Id Valid Key Ids | List of Key
Ids that open this lock Valid Key Refs | References to the spawned
key game objects that open this lock
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Sample
Game Sample Scene: Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Scenes/Gr

The GridFlow game sample contains a working example of how you
can implement a key lock system. There are many ways of implement-
ing this, this sample shows one such way.

The Sample has the following scripts:

* Inventory: Saves the picked up keys in the inventory

* LockedDoor: A script that implements the door opening logic.
This script is added to the locked door prefab. When something
collides with the door trigger, it checks if it has an inventory. If
it does, it checks if the inventory contains any of the valid keys
that can open this door

LockedDoor script location: Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Scr3

bool CanOpenDoor(Collider other)

{
var inventory = other.gameObject.GetComponentInChildren<Inventory>();
if (inventory != null)
{
// Check if any of the valid keys are present in the inventory of tf
foreach (var validKey in validKeys)
{
if (inventory.ContainsItem(validKey))
{
return true;
}
}
}
return false;
}
Mini-Map

Display a 2D minimap with fog of war
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The DungeonGridFlow prefab already comes pre-configured with the
minimap. This is done with the GridFlowMinimap component:

¥ « v Grid Flow Minimap (Script) i+ 8
Script GridFlowMinimap ]
Update Frequency |CI.EI5 |

| Enable Fog Of War |
Minimap Texture |l DefaultMiniMapTexture | @
Composite Shader |5 DungeonArchitect/MiniMap/Compos @
Tile Shader @DungeunArchitect.-’MiniMap..-"l’ile | ]
Init Mode | On Dungeon Rebuild i
¥ Icons
Icon One Way [)1:111:11\l icon_minimap_onewaydoor | o]
See Through Walls [ |

Parameter | Description Update Frequency | Control the frequency
of minimap updates. The updates can run at a lower fps for better
performance Enable Fog of War | Hides parts of the map that is
not explored yet See Through Walls | If this is disabled, unexplored
area behind a wall will not be made visible. This works if Fog of War
is enabled Minimap Texture | The Render Target texture that the
minimap will be rendered on Icons | The icons to overlay on special
tiles

115



Init Mode values:

Parameter | Description On Dungeon Rebuild | The minimap layout
texture is regenerated when the dungeon rebuilds On Play | The
minimap layout texture is generated when you start play Manual
| The minimap layout texture is generated only when you manually
build it from script

Setup

The minimap requires you to provide a Render Texture asset in the
Minimap Texture property. The minimap will be rendered in this tex-
ture. You can then apply this texture anywhere (in your Ul elements,
in a mesh etc)

Create a new Render Texture asset. Use the Create menu in the
Project window: Create > Render Texture

3 Project
Create ~ =1

Folder f

CE Script

Shader H
Testing -]
Playables ¥
Assemnbly Definition

TextMeshPro ¥

Scene

Post-processing Profile
Prefab Variant

Audio Mixer

Material
Lens Flare

Render Texture

Lightmap Parameters

Select the Render Texture asset and inspect the properties
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®mnspector [ e
. DefaultMiniMapTexture it <N

Change the following:

Parameter | Description Size | Change to 512x512 (or the quality
you are comfortable with) Depth Buffer | No Depth buffer (we don’t
need it here) Filter Mode | Point (so we get sharp tile edges instead
of a blurry image)

Assign this Render Texture asset to your DungeonGridFlow game
object’s minimap component

e | (GFAI ||| Shade
v € GridFlowBuilderDemo_Game* =

El Cunl

Reset called
UnityEngine Debug:Log({Object)

Dungeon Architect will automatically update this texture based on the
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specified Update Frequency. You can assign this texture anywhere
on your UL You can also attach it on a mesh

Show in Ul
Open the game sample scene: Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Sc

There’s a Ul canvas in the hierarchy. Expand and inspect it:

‘= Hierarchy

-

Rawlmage

There is a RawImage Canvas Item in there. It was created like this:
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Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty
3D Object H
2D Object >
Effects
Light
Audio
Video

B3 Project

Text
Text - TextMeshPro

Button
Button - TextMeshPro

Taggle

Select the Rawlmage item and configure it like this:
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MiniMapUIMat

Shader | DungeanArchitect/MiniMap/Ur |
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The Render Texture was assigned there so it will show our minimap

Add to a Material

While playing the sample game, if you look down, you notice the
player holding a map in the hand (like in Minecraft). This map shows
the minimap in realtime
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The texture was simply added to an unlit material, and the material
was then applied to that mesh

Create a Material as below:

v Mat_TabletScreen @ 3 %,
Shader | UL/Unlit/Transparent " |

Base (RGB), Alpha (&)

Tiling 1 Y1
Offset w0 Y0 —
Tint |

» Set the Shader to UI/Unlit/Transparent
* Set the texture to your Render Texture asset

You can now apply this material anywhere (e.g. in a large billboard in
your world, a small map that the player holds, dashboard of a vehicle
etc)

:::note See Also Check the sample game to see how this was done

Asset | Path Tablet Prefab | Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Art/Prefa
Material | Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Art/Materials/Mat_TabletS
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¥ o« W Grid Flow Minimap Tracked Object (Script) L o
Icon Settings

Icon Aicon_minimap_plaver @

Icon Scale 2

Rotate Icon o

Tint .y
Fog of War

Explores Fog Of War [

Fog Of War Num Tile Radi 7

Fog Of War Light Falleff S10.35

Figure 29: Added to the Player prefab

¥ = | Grid Flow Minimap Tracked Object (Scrip [l 5! #

Icon Settings

Icon icon_lo_skull o
Icon Scale 1.25

Rotate Ican -

Tint ¥
Fog of War

Explores Fog Of War ||

Figure 30: Added to the Enemy prefab

Minimap Tracked Objects

The minimap can track any object in the scene. You do this by adding
the GridFlowMinimapTrackedObject component to the desired pre-
fab

It has the following features:

* The tracked object can explore the minimap (e.g. player and
allies)

* Specify an icon, color and scale of the object in the minimap

* the icon can rotate to indicate the game object’s Y rotation (good
for player game objects)

You’d want to turn on Explores Fog of War only for the player and
other relavant objects. The icon can be greyscale and you can apply
a tint on it with different colors (e.g. on key icon but different colors
applied to the red key prefab, blue key prefab and so on)
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:::note See Also Check the sample game prefabs to see how the
component was configured

Asset | Path Player Controller | Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Sc
Grund NPC | Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Scenes/DemoGameS
Key (Red) | Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Art/Prefab/KeySku'
Key (Blue) | Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Art/Prefab/KeySku
Door (Yellow) | Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Art/Prefab/Dool
Door (Green) | Assets/DungeonArchitect Samples/DemoBuilder GridFlow/Art/Prefab/Door
::: # Snap Flow Builder

Setup Snap Dungeon

The Snap Builder generates a dungeon by stitching together pre-built
rooms prefabs. The rules for stitching them is controlled by Graph
Grammars

In this page, we’ll walk through the creation process.

Preparing the Scene

Create a new scene and drop in a Dungeon Snap game object. This
will allow you to build snap dungeons
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%= Hierarch

3 Project
| & | |4 ||

Dungeonarchitect > P

DungeonSnap *

Creating Module Prefabs

A module is a prebuilt prefab of a area (like room, corridor etc)
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Design a room in the editor so we can turn it into a prefab for use
with the snap builder

We've left holes at places where we want a possible door. We’'ll place
a special Connection prefab later at these places to let Dungeon
Architect know that it can stitch the rooms from these points

Go ahead and create a few more module prefabs. We’ve created one
for a corridor below
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Connections

A Snap Connection tells DA how to stitch the room modules together.
They are usually the Door Entry / Exits.

The connection also contains references to two assets, a references
to a Door prefab and a reference to a Wall prefab.

If DA stitches another module through that connection point, it would
place the specified Door prefab in that place. Otherwise it would fill
up the gap with the specified Wall prefab

Design a new Connection prefab by creating an emtpy Game Object

| Create T| (’Q;rﬁ.lli
i Create Empty
Create Empty Child
3D Object »

Reset the transform of the newly created emtpy Game Object and
rename it
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@ Inspector
& [MyConnection | [] static «

Tag [Untagged  ¢|layer [Defaur i

Move to Front

Move to Back

Copy Component

Add a SnapConnection script to it

= Cmpoanegn

B Snap Connection S

This script takes references to the above two mentioned prefab refer-
ences, one for door and another for wall

Drop your Door and Wall prefabs under the Connection prefab
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B3 Project

.il-. ets » DungeonArchitect_Samples » Demo_The

Align the door and wall prefabs so the Red line is perpendicular to it
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Now set these child door / wall prefab references on the SnapCon-
nection script

LRI TEELEn ¥ .~ Transform i+ 8
& wall1 ositi.on 0 o |z [o |
otekion X0 o |z[o |

s (1 |1 |z[1 |

¥«  SnaplCo tion (Script) [ = 4

Script SnapConnection @

Door Object [ Doorl | @

Wall Object [ walll |

Category [ |

Your connection is ready. Turn this into a prefab so we can reuse this
in our modules
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MyConnection

Drag and drop the connection prefab on your previously generated
modules. Make sure the red line points outwards from the opening

Make sure the red line is pointing outwards and is on the edge of the
module bounds
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It is a good practice to design with the snap settings (Edit > Snap
Settings > Snap All Axis)

Repeat by drag-dropping on all the door openings. Do this for all the
other modules as well (like the corridor module)
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Save/Update your module prefab

Register the Modules

Register your modules in the DungeonSnap game object so Dungeon
Architect can use it to build the dungeon

Inspect the DungeonSnap Game Object

¥ =  Snap Config (Script) Q= %,
Script SnapConfig ]
Seed 423
Mode 2D -
¥ Modules
Size 2
¥ Element 0
Module wModule_Room @
Category Room
¥ Element 1
Module wModule_Corridor ]
Category Corridor
Mumaann Floow [Mare MMNnnenn Flaw Aceatd l @

Here we’ve registered the two modules and assigned a Category
to them (e.g. Room, Corridor, TreasureRoom, MiniBoss, MainBoss,
SpawnRoom, Exit etc).

You can have multiple module prefabs assigned to the same category.
These categories are used in the Dungeon Flow graph to design a
procedural layout graph for your dungeon

Design Snap Flow Graph

A Dungeon Flow graph allows you to control the layout of your dun-
geons using Graph Grammars. You can generate interesting graphs
with simple rules

Create a new Dungeon Flow Asset by right clicking on the Projects
window. (This can also be done from the Create menu in the Projects
window or Assets > Create from the editor’s main menu)
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Create > Folder

Show in Explorer

C# Script
Open
Shader >
D Testing >
Eehane Playables >
opyiPat ClliagiiE Assembly Definition
Open Scene Additive Assembly Definition Reference
Wiew in Package Manager feclichby ’
Dungeon Architect > Dungeon Theme
Import MNew Asset...
Import Package 5 Scene Snap Builder > Snap Graph
Export Package... Post-processing Profile Grid Flow Builder > Snap Connection
Find References In Scene Prefab Variant Snap Grid Flow Builder 3
Select Dependencies Audio Mixer Landscape ¥

<

MyDungoenFlow

Double click the asset to open the Dungeon Flow Editor. Doc this
window in a large area

i€ GarmeSeanel| Dungeon Flow Editor

+ % A v | 145 Graph

Entry

Error List

Add two new nodes Room and Corridor. You can change the name
of the nodes from the inspector window
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These names map to the names you specified on the Module registra-
tion in the DungeonSnap game object

Mode List

Select the Start Rule and on the RHS, delete the default T node and
drop in a few Room nodes like this:

Fule List
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Room:3

Room:4

Room:0 ——®» Room:l ———#% Room:2

Rckm:&

Cycles are not supported by the SnapMap builder

Execute the rule and see how the final graph is generated. You do
this by clicking the Run icon on the Execution graph panel
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Graph

Entry —_— Start Rule

Run Once

Room

Room — Room Room

Room

Room

We’d like to insert Corridors between the rooms. Create another rule
and give it a name (e.g. Insert Corridors)
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Rule List

Start Rule

Room:0 |——————p Room:l

Room:0 = ———=  Corridor:2 |— Room:l

Node List

On the LHS, we want to find a patterns where two rooms are con-
nected to each other like this (Room -> Room) and have it replaced
with (Room -> Corridor -> Room)

The Graph Grammar will find a pattern you specify on the LHS and
replace it with the one you specify on the RHS

The Indices on the nodes (e.g. Room:0, Room:1) are important that
helps in correct mapping. Since we properly specified 0 and 1 indices
on the RHS, it knows the direction of the newly created links to the
corridor. This will be covered in detail in the full documentation soon

You control how your rules are run from the Execution Graph. Drag
drop your newly created Insert Corridor rule on to the execution
graph and connect it after the Start Rule.

fl ruic

Select the newly placed node and from the details panel, change the
execution mode to Iterate and set the count to 2 or 3 (This makes the
rule run multiple times since the newly replaced Room nodes wont
map with the adjacent older Room nodes by design and need to be
run again)
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Task Node

Run Mode [ Iterate m

Iterate Count Run Once

Run With Probability

Execute the grammar and you’ll now see corridors between your
rooms

Insert Corridors v |terat

Run 2 t
[terate Range

Corridor - Room

Room — Corridor G Room Corridor - Room

Corridor - Room

Corridor - Room

We will use this Dungeon Flow graph grammar to generate our snap
dungeons

Build the Dungeon

Assign the Dungeon Flow assets to the DungeonSnap game object

¥ cu Snap Config (Script) ﬁ 8
Script SnapConfig o
Seed 423
Mode 2D ]

Modules

Dungeon Flow |;EMyDungq\enFlnw {DungennFﬂ @
Main Branch Size 10 I
Rotate Modules To Filsf
Collision Test Contre 2
Max Processing Pow 1000000

- {+]
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Hit Build Dungeon. Randomize the seed and get different configu-
rations that satisfy the layout graph you defined in the flow asset.
Change the Dungeon Flow graph and experiment further

Explore the Sample for a more complex and complete dungeon map
with multi key-lock system, treasure rooms guarded by miniboss, exit
guarded by a Boss room which requires a key to unlock

Location: DungeonArchitect Samples\DemoBuilder Snap\Scenes\DemoScene
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Snap Grid Flow Builder

Introduction
Features

The Snap Grid Flow Builder allows you to stitch snap modules
using a flow graph. You can create many types of levels with this
builder. Some examples include: * FPS/TPS with multiple floors *
Side Scrollers * Top-Down dungeon crawlers (like diablo) * Cities
(with custom road paths, subways etc) * Race Tracks

Since this builder uses parts of the Snap builder and the Flow frame-
work, you can do the following: * As an artist, have complete control
over the design of the individual snap rooms. Use vertex painting,
foliage, landscapes, custom gameplay elements etc. on your snap
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room modules * Use the flow framework to design procedural lay-
outs, leveraging all the existing features like cyclic-paths, key-locks,
one-ways doors, item spawners etc * Use Level streaming to keep the
framerate high, even with lots of dynamic lights

3D Flow Graph
You’'ll design the flow graph in a 3D Layout Grid

The snap rooms are required to be of a fixed size (that is chosen by
you), so they all can fit nicely and can be stitched inside the 3D grid.

However, you may also design your snap rooms to span multiple nodes
in the flow graph. The flow framework is smart enough to identify
these rooms and use them appropriately in the flow graph:
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In this example, the goal room was designed to be 2x2x2 the size
of the chunk. The flow framework identified it and created a larger
node appropriately while building the flow graph

GOAL ROOM

The flow framework will also read the available doors you’ve setup in
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your snap modules and use that configuration to grow the graph. So
you are free to leave out the doors that you don’t want while designing
your snap module

This means, you don’t need to leave space for doors on each side of
the room. You can safely wall them off with your art assets, and it
won’t grow from there

Modules

A room is designed in a separate prefab, and it is called a Module

All Modules in the Snap Grid Flow builder have a fixed size called the
Chunk Size. Your module size can be in mulitples of this size (e.g. you
can create a taller room of size 1x2x1 or a bigger room 3x2x3)

Module Bounds

Start by creating a Snap Grid Flow - Module Bounds asset. You
will assign the size of your modules here and use it while designing
the modules

In the Projects tab, navigate to the desired folder and create the Snap
Grid Flow Module Bounds asset

Folder
C# Script -
Shader ¥

S 4 Testing »

Show in Explorer Playables 2

Upe Assembly Definition
Delete Assembly Definition Reference

ReLaps TextMeshPro >

EopyiEath HEGhsE Dungeon Architect » Dungeon Theme

0 S A
Open Scene Additive eene Snap Builder >

View in Package Manager Prefab Variant Grid Flow Builder >

Snap Grid Flow Builder > Snap Grid Flow Graph
Module Bqunds
Module Datsbase

Find References In Scene Placeable Marker

Render Texture
ol et P ]

Import New Asset... Audio Mixer

Import Package > Landscape »

Material

Export Package... Lens Flare
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Tutorial

SnapGridFlowModuleBounds

i Tutorial
Im Packages

Double click the asset to open the editor * Set the Chunk Size to
something like (40, 20, 40). The X and Z has to be the same if you
want your modules to support rotation. In this case, we’ve provided
40 for both * Set the Door 0ffset Y to 5.

Door Offset Y determines how high the door is from the base of the
module. It is a good idea to leave some gap, so you have space to
create some pits or lower areas

You’ll use this asset on each of the module prefabs you design

Create a Module

Modules are rooms that are designed and saved into a prefab. We’ll
design a new room module prefab

¢ Create a new scene

* Create an empty game object and name it to Room 1x1A
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= Hierarchy

+1|r

< Untitled*

] Main Camera

Q Inspector

) v Room_1x1A

Tag = Layer Default

[

Mowve to Front

MMowve to Back

¢ Add the Snap Grid Flow Module component to it

Add Component
2 snapgridflowmodule
Search

Snap Grid Flow Module

Mew script

3
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O Inspector

[L1 ¥ Room_1x1A

Tag Layer Default

41 Y 1 &1

k."-l one (Snap Grid Flow Module Bounds)

Add Component

Assign the module bounds asset we created earlier

Snap Grid Flow ModLule (Script)

Mum Chunks X 1

hodule Bounds SnapGridFlowhModuleBounds (Snap 1 @

Draw Bounds

Your module prefab will now provide visual information that will help
you design your room
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:::warning Note If you don’t see the red lines, make sure the Gizmos
button is pressed in the Scene View tab’s toolbar

The red wireframe indicates the bounds of your module. You may fill
this up in any way you like.

The blue indicators show the possible locations of the doors

Design your module inside the level bounds.
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Note how the ground mesh was aligned to a height where it matched
the door indicators (blue lines). These blue lines were previously
configured to be 5 units above the module’s base (DoorOffsetY)

Go ahead and design the rest of the room in any way you like
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Make sure all your game objects are inside the module game object

In this simple example, we want to have doors on all the 4 sides. A
gap of 4 wide / 5 high was left out at the door openings. Our door
and wall assets will eventually be of this size to fill up the gap
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Do this for all the four doors

While designing the rooms, it is always a good idea to use Grid snap-
ping (Edit > Grid and Snap Settings)

Set Position Handle

Increment Snap

Align Selection to Grid

All Axes X

More info on snap settings here

You can always turn off the module bound visuals (the red box) if
it gets in the way. Do this by unchecking Draw Bounds in the Snap
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https://docs.unity3d.com/Manual/GridSnapping.html

Grid Flow Module component

Snap Grid Flow Module (Script)

Mum Chunks

Save as Prefab

Select the module game object Room 1x1A and save it as a prefab in
some folder

‘= Hierarchy
+-

<} SGFTutorial*

I Project

torial > Modules

Now that we have it saved as a prefab, delete the module game object
from the scene
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= Hierarchy
+-~

€ SGFTutorial*

aln Carmera

= Hierarchy

+~

In the next section, we’ll create a Connection and add it near the
door openings## Connections

A Connection is a stitching point that the Snap framework uses to
join rooms together. A connection contains a reference to a Door
asset and a Wall asset.

If two rooms are stitched together through this stitching point, a door
will be displayed in that position, otherwise the empty space will be
walled off by the specified Wall asset

Create a Connection Asset

Create a new Snap Connection asset in a folder

Create > Dungeon Architect > Snap Grid Flow Builder >
Snap Connection
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Folder
€# Script
Shader
Testing

Tuterial > Connections

Create » Playables >

Show in Explorer Assembly Definition
Open Assembly Definition Reference
Delete TextMeshPro ¥

[Renams] Dungeon Architect Dungeon Theme

Copy Path

Alt+Ctrl+C Scene Snap Builder >

e Prefab Variant Grid Flow Builder >

Snap Grid Flow Builder > Snap Grid Flow Graph

View in Package Manager Audio Mixer
Module Bounds
Material Landscape >

mport Mew Asset... Medule Database
Import Package > Lens Flare Placeable Marker
Export Package... Render Texture Snap Connection
Find References In Scene Lightmap Parameters

Select Nenendencies Lighting Settings

This will create a snap connection prefab asset that you can open and
customize

al » Connections

SnapConnection

Customize Connection Asset

Select the newly created snap connection asset and click Open Prefab
from the inspector tab

After you’ve opened the snap connection prefab, you’ll see that it is
setup like this:
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= Hierarchy

+-r =T

- - -
P SnapConnection

nnection

You will place your wall assets under the Wall game object and the
door assets under the Door game object

Dungeon Architect will take care of automatically showing the appro-
priate game object (wall or door) and hide the other one

Setup Wall Asset In this example, we’ll use a simple cube as a wall.
Create a new cube mesh from the create menu

= Hierarchy =l Scene @ Gam

Create Empty J Scenes
Create Ermpty Child

30 Object H

20 Object H

Effects -] Capsule

Light ] Cylinder

Parent this cube under the Wall game object.

= Hierarchy

+—r a5

- ~ -
&P SnapConnection

onnection
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‘= Hierarchy

-
L]

SnapConnection

aConnection

1 Door

We need the wall to be 4 units wide and 5 units tall (to cleanly cover
up the gap we created in our modules previously)

Select the cube mesh and set the scale to (4, 5, 1)

The wall should be moved appropriately so that: * The red line is at
the bottom-center of the wall * The wall should be behind the red
line’s origin point

Move the wall up and a bit back by setting the location to (0, 2.5,
-0.5)
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@ Inspector

Tag

- Transform

Position

Setup Door Asset There’s a simple Door prefab that comes bundled
with the samples. We’ll use that here, however, feel free to use your
own door prefabs
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Navigate to Assets\CodeRespawn\DungeonArchitect Samples\DemoBuilder GridFlow\Art\P
and drop in the DoorLarge prefab under the Door game object

- ~ .
¥ SnapConnection

BND2IDDDY

*

W WY W W

DoorLargelLo

JemoiGame
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Go ahead and hide the Wall game object. Dungeon Architect will
take care of making it visible where needed

. ;
¥ SnapConnection

FD SnapConnection
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:::warning Important You may safely hide the main Wall or Door game
objects but do not hide what is underneath it. For example, do not
hide the Cube or the DoorLarge game objects :::

The rules for aligning the door with the red line are a bit different

You should move the door asset so that: * The red line is at the bottom-
center of the door * The origin point of the red line should be at the
center of the door
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Our door prefab is already of the correct size (5 units tall and 4 units
wide) and the pivot is in the right position. So reset the transform of
the DoorLarge game object
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.' + DoorlLarge

-
Tag Unr.agge*
Prefakb Open

- Transform

Position
Rotation

Scale

You’d want your door asset to be twice as thick as the walls. This is
because when two adjacent modules are stitched together, we have
two walls from each modules and a door that is twice as thick as the
walls will cleanly fill up the gap

Setup One-way Door Asset Some doors will be promoted to one-
way doors. This is done so that the player doesn’t bypass a locked
door and enter through another nearby door. You'll need to provide a
door prefab that opens only from one way

Right now, the snap connection is setup to support a Door and a Wall.
We are going to add support for a one-way door.

1. Create a new game object and name it OneWayDoor. This should
stay alongside the Door and the Wall prefabs

= Hierarchy
4+~ =

Create Empty ection
Create Empty Childlk
3D Object :
20 Object ?
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- - -
P SnapConnection

nnection

Layer Default

Maove to Front

Move to Back

e e e e e — L

Layer Default

3. Let the SnapConnection know that this game object represents
a one-way door. Select the root SnapConnection game object
and inspect the properties
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= Hierarchy

ﬂ Snap Connection (Script)

Snap Connection

apConnection

7] DoorOneWay

[#] Snap Connection (Script)

Snap Connection

Add Component

We can now place our one-way door assets under this. Navigate to As -
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sets\CodeRespawn\DungeonArchitect Samples\DemoBuilder GridFlow\Art\Prefab
and drop in DoorLargeOneWay prefab as shown below

‘= Hierarchy

+ -
& o = ;
¥ SnapConnection

nnection

n“j
Ny

E-E)

The alignment rule of a one-way door is similar to a door. The direction
in which we are allowed to go through the door should follow the red
line outwards
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Reset the transform of the asset and rotate it along Y by 180 degrees
since it is facing the wrong way

f SnapConnection

geOneWay
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yorLargeOneWay

ag Untagged

Open

Transform

¥ 180

Y 1
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Hide the Door and DoorOneWay game objects

- - -
@ SnapConnection

B SnapConnection

Make sure you hide the outermost object, namely Wall, Door and
DoorOnewWay

Our snap connection is now complete and we are ready to place them
in our snap modules
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Exit out of the snap connection prefab and return to the scene by
clicking the Scene button on the viewport

# Scene oW Game Snap Grid Flow

Shaded *~ I %

SnapConnection

Place Connections on Modules

It’s now time to use this snap connection on our modules

Open up the Room 1x1A module prefab we created earlier

Modules

[ Assets

e AssetSto
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Open the Grid and Snap window so we can align our snap connec-
tions correctly. Navigate to Edit > Grid and Snap Settings

ﬂ DAZ20.1X - 5GFTutenal - PC, Mac & Linux Standalone - Unity 20z
File | Edit Assets GameObject Component Asset Store Too

Undo Selection Change Ctrl+Z
Redo Ctrl+Y

Select All Ctrl+ A
Deselect 4ll Shift+D

Preferences...
Shortcuts...
Clear All PlayerPrefs

Graphics Tier

Grid and Snap Settings...
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Handle
Increment Snap

Mowve

Scale

Align Selection to Grid

All Axes

Move over to one of the doors in the module prefab
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Drag and drop the snap connection and align the snap connection
origin point in the blue door position. Make sure the red line points
outward
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The position and rotation might be off by a slight margin. Select the
snap connection actor and click ALl Axes button on the Grid and
Snap window and it should cleanly snap at the door position

Repeat this for all the 4 door openings
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Module Database

A Module Database is a registry of all the available modules that
Dungeon Architect can use to stitch the dungeon

It also contains an acceleration structure with all the necessary infor-
mation pre-calculated in the editor, so the stitching is fast at runtime

You may have different module databases to generate dungeons with
different art styles (e.g. Sci-Fi spaceships, Medieval castles etc)

Create a Module Database

We’ll create a new module database asset and register the module
that we created in the previous sections

1. Move to an appropriate folder and create a module database
from the Create menu:

175



orial > Modul

Create

Show in Explorer
Open

Delete

Rename

Copy Path
Open Scene Additive
View in Package Manager

Import New Asset...
Impert Package
Export Package...

Find References In Scene

Select Dependencies

Alt+Ctrl+C

E]

Folder

C# Script
Shader
Testing
Playables

Assembly Definition

Assembly Definition Reference
TextMeshPro

Dungeon Architect

Scene

Prefab Variant
Audio Mixer

Material
Lens Flare

Render Texture
Lightmap Parameters
Lighting Settings

Custom Render Texture

Modules

% SnapGridFlowModuleDEB

Dungeon Theme

Snap Builder y
Grid Flow Builder >

Snap Grid Flow Builder > Snap Grid Flow Graph
Landscape N Module Bounds

Maodule Database %
Placeable Marker

Snap Connection

2. Select the module database and inspect the properties
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Module Bounds

hodule Baun

Module Prefabs

Modules

&

Modules

Compile Module Database

4. You’'ll also need to provide the bounds asset that is used in all of
the registered module prefabs
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=
(-
Open

Compile Module Database

Module Prefabs

All the modules registered under this module database should
use this same bounds assets

. Finally, Click Compile Module Database whenever you make
any changes to either the module or the module database. This
will do some internal calculations in the editor so your dungeons
can build fast at runtime

Module Bounds

Module Bound

Module Prefabs

:::warning Important This is an important step. Do not forget to
recompile the module database whenever you make any changes
to it or the modules themselves :::

178



Create Flow Graph

Design the layout of your procedural dungeons using the flow editor.
Then create an infinite number of procedural dungeons that follow
this layout rule.

Create cyclic-paths, key-locks, teleporters, shops, treasure rooms,
boss rooms and much more
Create a Snap Grid Flow Asset

Move to an appropriate folder and create a new Snap Grid Flow
Graph asset from the Create Menu

Create > Dungeon Architect > Snap Grid Flow Builder >
Snap Grid Flow Graph

Folder

C# Script
Shader
Testing

Playables >

Assembly Definition

Create 4 Assembly Definition Reference
Show in Explorer TextMeshPro >
Open Dungeon Architect > Dungeon Theme
Delete
" Scene Snap Builder >
ename
- - T Prefab Variant Grid Flow Builder >
opy Pa +Crls
- pa— Snap Grid Flow Builder > Snap Grid Flow Graph |+
Open Scene Additive e 5 Module Bounds
Material
View in Package Manager Module Database
lasffit Placeable Marker
Import New Asset... Render Texture S Eermsrer
Import Package 2 Lightmap Parameters
Export Package... Lighting Settings
Find References In Scene Custom Render Texture

gts » Tutorial > Flow

Gty SnapGridFlow
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Double click the asset to open up the flow graph editor

The top panel is the Exection Flow Graph where you would be design-
ing your dungeon flow. The resulting layout graph is shown in the 3D
viewport below

3D Viewport Navigation The navigation is similar to what you’d
expect from Unity’s scene view

* Hold right mouse button and move to look around.
* Hold right mouse button and WASD to move
* Hold right mouse button and Q to move up, E to move down

Create Grid

Right click on the execution graph and add a Create Grid node from
the context menu

Layout Graph > Create Grid
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S same aNap ard

cution Graph

L

Layout Graph Create Grid
Create Main Pa&
Create Path

Add Comment Mode

Spawn lterns
Create Key Lock
Finalize Graph

Create Grid Result

Link the Create Grid node to the Result node

Create Grid ——#»  Result

To create a link, hover the mouse pointer over the border of the
Create Grid node until it turns yellow. Then drag a link out of it and
attach it to the border of the Result node

Hit the Build button in the Execution Graph Panel
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Move around in the 3D viewport and should should see a faint set of
dots that represent the initial grid that this node has created. This is
our work area and our dungeon layout will grow in it

Select the Create Grid node and inspect the properties

Grid Info

Reso

Description
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You may adjust the size of your initial work area here.

There are a few things to consider when choosing the size of your
grid * Larger initial grids will require more processing power.

* Sometimes, it’s better to have a smaller grid so it creates a nice
tightly packed layout.

* However if the grid is too small, the paths will not have any room to
grow

You should come back to this node and adjust it as needed. For now,
we’ll leave it to default
Create Main Path

Add a Create Main Path node
Layout Graph > Create Main Path

Create Grid |———®  Result

Layout Graph Create Grid
Add Comment Mode iz DD P L\)
Create Path

Spawn ltems

Create Key Lock
Finalize Graph

Create Grid ——»  Result

Create Main Path

Break the previous connection we made to the result node and link it
like this
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Create Grid — Create Main Path

—  Result

3

To break the link, hover the mouse over the Create Grid node’s
border till it turns yellow. Then right click

Hit build

Keep hitting build for different results

More Viewport Controls

e Hold Alt + Hold Left Mouse button + Move mouse to orbit around
the selected nodes

* Press F key to focus on the active nodes and reset the orbit pivot
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Main Path Properties Select the Create Main Path node and in-
spect the properties

Path Info
Pa Ze 12

main

al Marker Name

Start / Goal Nodes

ma

main

Position Constraints
P ion C traint

Snap Module Constraints

L egory nstraint iV
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Parameter | Description Path Size | Control the size of the path with
the variable Path Name | Each path in the flow system can be later
referenced using its path name. The name of this path is set to main
Snap Module Categories | When you registered a room in the module
database, you specified a category (which defaulted to Room). This
allows you to control the module prefabs that would be used from
that list to stitch the path Node Color | Adjust the preview color of the
nodes created in this path Start/End Marker Names | These values
allow you to insert your prefabs into the start / end rooms using
the theme engine. More on this later Start/End Node Path Name
| Override the path name of the first and the last node in the path.
This allows you to give a unique path name to your spawn room and
goal room Position Constraints | Control the position of the nodes in
the path with your own scripts and rules. More on this in the later
sections Snap Module Constraints | Override the snap modules for
any of the nodes in the path with your own scripts and rules. More
on this in the later sections

We’ll leave all the properties unchanged for now

Create Alternate Path

Add a node Create Path and connect it as below

Layout Graph Create Grid

Create Main Path
Create Path

Add Comment Node

Spawn ltems

Create Key Lock

e

Create Grid  ——®  Create Main Path ———b-—b Result

Select the node and inspect the properties

186



>reate Path

Path Info
Min Path Si 3
Path MName branch

Mode Color

EBranching Info
Start From Path main

End On Path

Snap Info
Snap Module Categories
size

Element O

Position Constraints

Position Constraint

Snap Module Constraints

Categary Constraint M

Misc

Description

Build the graph, and you’ll see a new branch (orange) emitting out of
the main branch (green)
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This new orange path branched out of the main (green) path be-
cause we have configured it to do so by setting the Start from Path
parameter to main

We would like to have this new path merge back into the main path.
Set the End on Path parameter to main. We also want to reference
this new path as alt

Lreale Fath

Path Info

Min Path Si

\ax Path Size

Path Mame

Meade Color

Branching Info

Start From Path main
End On Path main

r

Snap Module Categories

Snap Info

Size

Element 0

Control the size of the path with the Min/Max Path Size parameter
Add a description to this node
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Misc

Description Alternate Path

— | CreatePath |— Result
Alternate Path

It’s a good practice to add description to your nodes, as it becomes
easier to manage them when you graph grows bigger

Create Another Path

We’ll create another path originating from the ‘alt’ path and merging
back into the ‘main’ path

Create Grid | —  Create MainPath | —p  CreatePath __ | CreatePath | = p.o

Alternate Path AIlPalkz
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Create Path

Path Info
hin Path Size
Max Path Size
Path Mame

Mode Color

Branching Info
Start From Path

End On Path =

Snap Info

Position Constraints

on Constraint Mode

Snap Module Constraints

Category Constraint Mode

Misc

Description

The path originates out of the alt path (orange) and merges beack
into the main path (green)
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Assign Module Database

The flow editor doesn’t have a module database assigned, so it doesn’t
really know how our modules look like

Let’s assign the module database in the editor settings, so it creates
a layout graph compatible with how we’ve set up the modules

Click an empty area in the Execution Flow Graph to view the editor
properties
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7 Grid Flow Editor Config)

Lle Database Mane (Snap Grid Flow Module Databas

Auto Focus Viewport w

Property | Description Randomize Seed | Randomize the layout ev-
erytime you build Seed | The current seed that was used to build the
dungeon Module Database | Specify a module database asset to build
the flow graph compatible with the regsitered module prefabs Auto
Focus Viewport | Whenever you select a node in the execution graph,
the camera auto-focuses on all the active nodes. Uncheck to disable
this

Assign the module database we created earlier

Execution Graph 6; Snap Grid Flow Editor Config @ &
b

. £ 11
al > Modules

foduleDB

Rebuild and have a look at the layout graph now
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You'll notice that the flow graph is built on a single floor, which
is consistent with the way we’ve designed our registered modules.
We have designed a room which, although it goes out in the four
horizontal directions, there’s no way of moving up or down.

If your build fails, make sure you’ve compiled your module database
and saved the asset

Create a Lift Module

Let’s create a module that lets us move to another floor

Design Lift Module Create a new module as we’ve done in the
previous Modules section

1. Switch to a new scene and create a new game object and name
it Module Lift

=4

F Module_Lift

3

2. Reset the transform
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modules.md

+  Module_Lift

Layer Default

Add Component

. Add a Snap Grid Flow Module component and assign the mod-
ule bounds asset

Snap Grid Flow Module (Script)

Mum Chunks

You should see the bounds of the module
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4. We want the module to span two node vertically
Set the Num Chunks parameterto (1, 2, 1)

Snap Grid Flow Module (Script)

Mum Chunks A1

SnapGridF
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5. Go ahead and design your lift module in any way you like. Leave
two openings on the same side of the room, one below and
another on top
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6. Drop in two snap connection prefabs and make sure they are
facing outwards. Align them correctly using the Grid and Snap
window
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Align S

All Ax
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7. Make sure all the objects that make up this room are inside the
module game object
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1 Directional Light
hodule_Lift

8. Save this module lift as a prefab
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‘= Hierarchy

+ -

< ModuleBuilder*

nera

I Froject
=+ -
# Favorites As Tuterial » Modules
i Art
¥ Module_Lift
]

9. Delete the Module Lift game object from the scene as we no
longer need it

= Hierarchy
+-

< ModuleBuilder*

Main Camera
A Directional Light

Register Lift Module Register this module in the Module database.
Select the module database asset and in the properties, register our
new lift module

201



Tutorial » Modules

lowhModuleDB

Element O

jule Prefab

Element 1

jule Prefab

Selection Weight

Since we’ve modified the module database, hit Compile Module
Database and save the asset
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Module Bounds

hadule Bound

Open up our flow graph editor and reassign the Module database in
the Editor Settings, as we’ve done previously

Click build and now, the flow graph uses the new lift module to move
to other floors
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.é

'.""-=l'.'—|-1 o rae——
. s

'

Notice how the links enter and exit out of the same side, since this is
how we’ve set it up in our module design
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Adjust Selection Probability We don’t want the lift to show up too
often. Open up the Module database and set the selection weight to
0.1 on the lift module entry
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e Prefab
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Before (with selection weight 1.0):

After (with selection weight 0.1):
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Create a Goal Room

We’ll create a large 2x2x2 room for the boss fight and register it under
the category Boss.

Design the Goal Room Prefab

1. Open a new empty scene, create an empty game object and name
it Room BossFight

= Hierarchy

+ -

Builder#*

tional Light
(] Room_BossFight

2. Reset the transform
O Inspector

v |Room_BossFight

3. Add a Snap Grid Flow Module component and set the num
chunks to (2, 2, 2)

Snap Grid Flow Module (Script)

A A L

Mum Chunks X 2 Y 2

iule B is Mone (Snap Grid Flow Module Bounds)

Draw Bounds

4. Assign the module bounds
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Snap Grid Flow Module (Script)

Mum Chunks X 2
! 2 Bounds SnapGridFl uleBounds (Snap .

vV Bounde

You should now see a the bounds visuals in the scene view. You have
a large area to design your boss fight arena

5. Design the module in any way you like.
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In our example, we’ll keep only one opening on the top floor, and the
player falls down to the arena to fight the boss

6. Add the snap module near the opening and snap it to the correct
position
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Handle

7. Make sure all your objects are inside the module prefab

= Hierarchy
+~
€ ModuleBuilder*

Main Camera

8. Turn this into a prefab
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Tuiorial > Modules

it
AoduleDB

t_LaunchPad

9. Delete the module game object from the scene

= Hierarchy
+-~

€ MaduleBuilder*

Directional Light
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Register the Module Register this module in the Module Database
with the category Boss

Module Prefabs

Element O

ction Weight

Element 1

le Prefab lodule_Lift (Snap Grid Flow

ight (Snap Grid Flov

Make sure the following parameters are set

Parameter | Value Module Prefab | Room BossFight Category | Boss
Selection Weight | 1

Since we’ve modified the module database, hit Compile Module
Database and save the asset

Modiule Bounds

Module Bound:
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Open up our flow graph editor and reassign the Module database in
the Editor Settings, as we’ve done previously

Select the Create Main Path node and inspect the properties in the
Details panel

Create Grid —p Create Main Path
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Main Path

Path Info

main

tart Marker Mame

al Marker Name

Start / Goal Nodes

*ath Name main

nfo

Element O Room

Position Constraints
Pasiti trai Mane

Snap Module Constraints

|. aint ¢ Mone

Change the Category Constraint Mode to Start End Node

This allows you to override the category of the start and the end
nodes.

Snap Module Constraints

Cateqg straint Mode Start End Node

This will force the flow system to pick up modules that are registered
under the Boss category. We previously registered our boss room
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with this category

You can have more than one module registered under the same cat-
egory. For example, you may have 3 boss rooms registered in the

module database under the category Boss and it would randomly pick
one while building it

Build the flow graph and have a look at the layout graph

N

The last node in the main path has a size of 2x2x2 to accommodate
our goal module. It also enters from the correct position

Create More Room Modules

Add a few more Room modules of size 2x1x1 and 2x1x2
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Register them with the module database under the category Room
and click Compile Module Database. Adjust their weights to control
how often they appear

Rebuild the flow graph
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N, @ e = e
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Build Dungeon

It’s time to use everything we’ve created to build a dungeon

Create Theme file

Create an empty theme file somewhere in the content browser. We’ll
visit this later to spawn items in our modules (like NPCs, Spawners,
Pickups, player prefab etc.)
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Create

Show in Explorer
Open

Delete

Rename

Copy Path

Open Scene Additive
View in Package Manager
Import New Asset...
Import Package

Export Package...

Find References In Scene

Select Dependencies

Refresh

Alt+Ctrl+C

Folder

C# Script

Shader

Testing

Playables

Assembly Definition

Assembly Definition Reference

TextMeshPro
Dungeon Architect

Scene
Post-processing Profile

Prefab Variant
Audio Mixer

Material

Dungeon Theme

Snap Builder
Grid Flow Builder
Snap Grid Flow Builder

Landscape

Rename it to GameItemTheme

Setup Dungeon Game Object

1. Create a new scene and drop in a DungeonSnapGridFlow
prefab from Assets > CodeRespawn > DungeonArchitect >
Prefabs
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‘= Hierarchy
+ L

<0 Untitled*

. Select the DungeonSnapGridFlow game object and inspect the
properties

= Hierarchy
+~
<4 Untitled®

hdain

Directional Lic
ik DungeonSnapGridFlow
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+ Dungeon (Script)

on Themes

Build Dungeon

Destroy Dungeon

We’ll assign the three assets we’ve created earlier

3. Assign the GameItemTheme create created above

er Default

Transform
Position

katation

# Dungeon (Script)

n Themes

GameltemTheme (Graph)

Build Dungeon
Destroy Dungeon

Snap Grid Flow Config (Script)

4. Assign the Snap Grid Flow Graph
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. DungeonSnapGridFlow
avorites
aterials

1 Untagged ¥ Layer Default

Open E g Overrides
A Transform
Pasition
Rotation

Scale

~ Dungeon (Script)
Dungeon Themes

0 GameltemTheme (Graph)
Im Theme _
ackage
Build Dungecn

Destroy Dunge

SnapGridFlow (Snap Grid Flow
Mone ( k D

5. Assign the Module Database

Layer Default

Transform
Position
Rotation

ale

B v Dungeon (Seript)

Dungeon Themes

GameltemTheme (Graph)

ckages :
2 Build Dunge

stroy Dungeon

Snap Grid Flow Config (Script)

Flow Graph SnapGridFlow (Snap Grid Flo
Module Datab SnapGridFlowModuleDB (Snap

Build Dungeon

Select the DungeonSnapGridFlow game object and click Build Dun-
geon
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= Hierarchy
+-~
¢ SGFTutorialScene*
Main Camera

iclFlow

+ Dungeon (Script)

Dungeon Themes

Element O GameltemTheme (Graph)
Debua Draw i
Build Dungeon

roy D

Change the seed and click build again to get a different dungeon
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Snap Grid Flow Config (Script)

e SnapGridFlow (Snap Grid Flow

Module Database SnapGridFlowModuleDB (Snap Grid Flo @

Debug Draw

You get a debug overlay of the layout graph rendered by default
when you build the dungoen. You’ll want to turn this off in your final
dungeon

Do this by unchecking the Debug Draw check box and rebuild the
dungeon

~ Dungeon (Script)

Dungeon Themes
Size

Element 0 GameltemTheme (Graph)

Debug Draw

3

Build Dungeaon
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Let’s keep the Debug Draw check box on for now so we can see the
layout graph overlayed in the scene

r.\: -
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Keep Things Organized
When you build the dungeon, it clutters up the hierarchy

rialScene*

We’ll configure it so that our dungeon is built under a certain game
object and won't clutter the root.

1. Create a new empty game object and name it DungeonItems
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Create Empty I}
Create Empty Child

3D Object

bl T} I

Static =
Layer Default -

=k
rs

Add Component

3. Set it to static
0 nspector

[1:1 + Dungeonitems

Tag Layer Default

4. Assign this game object to the DungeonSnapGridFlow gameob-
ject’s Pool Dungeon Scene Provider component
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Transform
Position

Rotation
x1

v Dungeon (Script)
Dungeon Themes
GameltemTheme (Graph)

Build Dungecn
Destroy Dungeon

Snap Grid Flow Config (Script)

Snap Grid Flow Builde ript)

n Pooled Dungeon Scene Provider (Script @ S

Item Parent Dungeonltems

¥ Snap Grid Flow Visibility Graph (Scriptjga® -

5. Click Build Dungeon again and our dungeon will be built under
the DungeonItems game object

Save Map

We’ve set up our dungeon game object. Save this scene somewhere,
we’ll revisit it later ## Placeable Markers

In this section, we’ll spawn items like NPCs, power ups etc in our
dungeon.

For this, we’ll do the following:

* Use the Spawn Item node in the flow graph. This will add items
in the layout graph

* Create Placeable Marker assets and drop a few of them in the
snap modules so that the builder can spawn them at those places
when necessary
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* Use the Theme engine to spawn the actual prefabs at those
marker locations

Spawn Items in Flow Graph

Open up our flow graph editor and reassign the Module database in
the Editor Settings, as we’ve done previously

1. Create a new Spawn Items node and link it up as shown below:

Layout Graph Create Grid
Add Comment Node Create Main Path
Create Path

Spawn lterns

Create Key Lock
Finalize Graph

CreatePath = __, = CreatePath = _p.| spawnitems |——  Result

Alternate Path Alt Path 2

2. Select the Spawn Items node and inspect the properties.
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1
main

Enemy

Spawn Method

Spawn M Linear Difficulty

n Variance 0.2

3. We want to spawn enemies in the main path (green) and the alt
path (orange).

* Add two entries to the Paths array and set the values to
main and alt

e Set the Item Type to Enemy

¢ Set the marker name to Grunt. Later in the theme file,
we’ll create a marker node named Grunt and place our NPC
prefabs under it
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yawn ltems

Spawn Info
Paths
Element O main
Element 1 alt
[tem Type Enenmy
Marker Mame Grunt

1

4. Rebuild the flow graph

The nodes now in the green path (main) and orange path (alt) have
red enemy items

5. Add a description to this node
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Misc

Description Enemies (Main, Alt)

Create Path > Spawn ltems —»  Result
Alt Path 2 Enemies (Main, Alt)

Placeable Markers

A placeable marker is an prefab you create, which you can then drag
and drop anywhere on your modules. You can then use the theme file
to spawn objects at that location.

A placeable marker prefab can contain more than one marker name.
For example, a placeable marker prefab named PM Enemies may con-
tain a list of marker names like (Grunt, FireTroll, IceTroll, Gob-
1in). In your snap module, you’'d place these markers in appropriate
locations (say 10 different locations within the room module).

If the dungeon builder needs to spawn a Grunt marker 4 times inside
the room, it will first find all the existing and compatible marker assets
placed in the room. In this case PM Enemies would be compatible
since it contains a Grunt marker. Since we have 10 of these in the
room module, it will randomly pick 4 from them and use the theme
file to spawn the grunt prefab

Create Prefab

1. Move to an appropriate folder and create a Placeable Marker
prefab from the create menu
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Create > Folder

Show in Explorer

C# Script
Open
Shader >
Delete Testing >
Rename Playables >
Eopeh EREENEC Assembly Definition
Open Scene Additive Assembly Definition Reference
View in Package Manager TextMeshPro 4
Dungeon Architect > Dungeon Theme
Import New Asset...
A N Scene Snap Builder y
. Post-processing Profile Grid Flow Builder »
il Beforenees I Seene Prefab Variant Snap Grid Flow Builder > Snap Grid Flow Graph
Select Dependencies Audio Mixer Landscape y CrtmaEam=s
Module Database
Refresh CileR Material Poceenaa |,
Reimport Lens Flare e
Render Texture

Reimport All
Liahtmao Parameters

2. Rename it to PM_Enemies

Tutarial » PlaceableMarkers

Ny PM_Enemies

3. Select the PM_Enemies prefab and inspect the properties. Add a
Grunt marker (since we specified this earlier in the Spawn Items
node). Add a few more markers for future use like IceTroll,
FireTroll, Goblin

Placeable Marker (Script)

able Marker

Grunt
lceTroll
FireTrall

E|||:e|1'u:e':=|

Add to Snap Modules Open up the previously created room module
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Tutorial > Modules

O Inspector

il toom_1x1A |

—
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We went ahead and added a bit of geometry int he room

The snap system gives complete freedom to the artist to design the
room as they see fit. In that same spirit, the artist should also have
control on where the markers spawn. This is where placeable markers

come in
Drag drop the placeable marker prefab that you’ve created before,
on to the scene
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Room_1x1A 5 # Room_1x1A

This will spawn a placeable marker game object on the scene. When
selected, it shows the descripton (Debug Text) of the placeable
marker.
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Rotate the actor as needed. The red arrow shows the orientation of
the marker. When the theme engine spawns an actor here, it will do
so with this rotation

Enemies

Add a few more markers. Add at least 4 markers, since we are adding
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a maximum of 4 enemy items per node in the flow graph using Spawn
Item, but adding more is always better

We’ll add a few more on top of the ramp

238



Do this for all the modules you've created so far that would need this
marker in it

Open up the Lift module and add a few more placeable markers there
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.l

Tutarial > Modules

o

B At

i@ Module_Lift
L]

leBound:
oduleDB
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o

Open up the 2x1x1 and 2x2x2 Room modules and add the markers
there as well
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Rebuild Module Database Cache

If you add / remove a placeable marker from a snap module, you’'ll
need to rebuild the module database cache

Select the Module database asset that we created in the previous
section and in the inspector, click Build Module Cache button. Save
the module database asset

,.l

utarial » Modules
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Module Bounds

Module Bounds Asset

Module Prefabs
Madules

:::warning IMPORTANT This is an important step. Remember to
rebuild the cache when needed :::

Update Theme File

We’ll use a theme file to actually spawn our enemy prefab.

Open Theme Editor Open up the existing theme file we created in
the previous section.

[y GameltemT heme

Double click on the theme asset to open the theme editor
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Realtime

Fence

Box select all the marker nodes and delete them

@ ow  Dungeon Theme

Realtime

Ground Wi Wi ol Fence

WallHalf
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v Dungeon Theme

Create Marker In the previous section, we assign the marker name
of Grunt in the Spawn Items node. In the theme file, we’ll create a
new marker node and name it Grunt

Right click on the graph and choose Add Marker Node
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Add Game Object Mode

Add Game Object Array Mode
Add Sprite Node

Add Marker Node

Add Comment Mode Ik

Select the marker node and from the inspector, change the Marker
name to Grunt

Marker

0 Inspector

Gh Marker Mode_Bc 777t

Marker Node

Mame Grunt
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Add Enemy prefab Add your NPC character prefab here. For this
tutorial, we’ll add a cube and adjust the size and scale

Navigate to Assets > CodeRespawn > DungeonArchitect Samples
> Demo Theme SimpleShapes > Prefabs and drop in Cube Red and
connect it the Grunt marker node to it

Grunt

$

Select the cube node that you just dropped and adjust the scale and
position
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1ealtime Update

Grunt

!

Save and close the Theme Editor

Build Dungeon

Open the map where we previously configured our dungeon and build
it.

You’ll see that enemies start to spawn at the locations where you've
placed the markers
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You can use this system to spawn anything (treasure chests, weapon
racks, power ups or any gameplay prefab)## Setup Key-Locks

In this section, we’ll add a few key-locks to our dungeon using the

250



flow framework
Open up the flow graph and assign the module database like before

re v Layout

Snap Grid Flow Editor Con' @ 3

Create Grid | —# | Create MainPath | — . | Create Path Create Path
> Alternate Path =i Al Path 2 .

Create Treasure Room

We’ll create a treasure room that is attached to the main path. We do
this by creating a new path (of length 1) that emits out of the main
path

Add a new Create Path node and link it to the end as shown:

Create Path Spawn ltems
—
ate Path Alt Path 2 Enemias (Main, Alt)

Y

Create Path

Treasura (Main)

Result #——

Select the node and inspect the properties
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reate Path

Path Info

1
1

treasure

I R,
y

Branching Info
Start From Path main

End On Path

Snap Info

Snap Module Categories

Element O

Position Constraints

Position Constraint Mode

Snap Module Constraints

straint Mode

Misc

Description Treasure (Main)

Set the Min/Max size to 1 since we want a single room to hold
the key

Set the path name to treasure. We’ll use this id later to place a
key here

Start from Path is set to main so this room is connected to the
main path

We want the treasure room to be isolated and don’t want it to con-
verge back to another path. Leave the End on Path parameter
blank

Change the Node Color to anything you like

Hit Build and you’ll see a new treasure room created
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Treasure Room Key/Lock

We want to lock the treasure room and have the key somewhere in
the main path

Add a new Create Key/Lock node and link it to the end like shown
below:

Create Path > Create Path > Spawn [tems
Alternate Path Alt Path 2 Enamias (Main, Alt)

Y

Result — Create Key Lock -« Create Path

Traasura Room Traasura (Main)

Select the Create Key/Lock node and inspect the properties
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Branch Info
Key Branch I E

sranch treasure

Marker Names
Key Marker Mame

Lock Marker Mame

Misc

Description Treasure Room

* Key Path - Since we want the key to be in the main path, set
this to main

¢ Lock Path - Since we want to lock the treasure path, set this to
treasure

* Key Marker Name - We’ll use the Theme Editor to spawn the
key prefab. Set the maker name to anything you like, however
you’ll need to create a corresponding marker node with the same
name in the theme file to spawn the key prefab. For this tutorial,
set this to KeyYellow

* Lock Marker Name - We’ll use the Snap Connection prefab to
spawn the locked door prefab. Set the marker name to anything
you like, however you’ll need to create a corresponding mapping
in the snap connection to spawn the locked door prefab. For this
tutorial, set this to LockYellow

Hit Build and inspect the layout graph
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A blue lock item was created on the link that connects to the yellow
treasure node. The key was placed somewhere in the main path
(green). The red arrow shows the key-lock relationship

Main Path Key-Lock

We'll create another key lock for the main path. The key would be in
the alt path (orange) and the lock would be somewhere in the main
path (green).

Add a new Create Key/Lock node and link it to the end as shown
below:

Create Grid = —#  Create Main Path | ——p  Create Path > Create Path » Spawn ltems
Alternate Path Alt Path 2 Enemies (Main, Alt)

'

«——| CreateKey Lock ¢—— CreateKeylock o Create Path
Main Path Treasura Room Treasure (Main)

Result

Update the parameters:
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Create Key Lock

Branch Info
Key Branch alt
ock Branch miain
Marker Mames
Key Marker Mame KeyRed

Lock Marker Mame LockRed

Misc

Description Main Path

Parameter | Value Key Path | alt Lock Path | main Key Marker Name |
KeyRed Lock Marker Name | LockRed Description | Main Path

Hit Build and inspect the layout graph
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Spawn Keys
Setup Theme File Open up the theme file we created earlier

Tutarial » Themes

Iy GamelternT heme
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Grunt

!

Create a marker node ane rename it to KeyRed

Add Garne Object Mode
Add Game Object Array Mode
Add Sprite Mode

Add Marker Hudeh
Add Comment Mode

Add Marker Emitter; Grunt
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Grunt KeyRed

!

Create another marker node and name it KeyYellow

Grunt KeyYellow

!

We’ll place our key prefabs under these.

The maker names are case-sensitive. So make sure you capitalize
them correctly

Navigate to Assets\CodeRespawn\DungeonArchitect Samples\DemoBuilder GridFlow\Art\P
and drop in the KeySkull Red and KeySkull Yellow prefabs on to
the theme editor and link them up
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Grunt

!

With this mapping, we’'ve defined what key prefab to spawn. Next,

we’ll create a placeable marker asset to define where to spawn these
inside the modules

Create a Placeable Marker Create a new placeable marker asset
and name it PM_Keys
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Create Folder

Show in Explorer C# Script

Open Shader

Delete Testing

Rename Playables

Copy Path GEETE Assembly Definition

Open Scene Additive

Assembly Definition Reference

View i TextMeshPra
View in Package Manager
Dungeon Architect Dungeon Theme
Import New Asset...
Import Package Scene Snap Builder
Export Package... Post-processing Profile Grid Flow Builder
Find References In Scene Prefab Variant Snap Grid Flow Builder Snap Grid Flow Graph
Select Dependencies Audio Mixer Landscape » Module Bounds

Medule Database

Refresh Ctrl+R Material r—— o
T Lens Flare Snap Connection
Pt an Render Texture

PlaceableM

Tutarial

'M_Enemies
M_Keys

3

Placeable Marker (Script)

Placeable Marker

* Add two markers KeyRed and KeyYellow
» Set the Debug Color to yellow
* Set the Debug Text to Keys

Place Key Markers Open up all your room modules and drop in
the PM_Key placeable marker asset, similar to what we’ve done with
the enemy placeable marker in the previous section
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Drop in at least 2 of these in a room, in case if both the Red and the
Yellow keys spawn in the same room

Either move this placeable marker game object up by 1 unit (so the
key doesn’t spawn buried half into the ground), or move the key up
in the theme editor by selecting the key nodes and moving it up at' Y
by 1 unit

Add to the other room modules as well
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Recompile module database Since we’ve modified the module’s
markers, we need to rebuild the module database cache

Select the module database and click Build Module Cache

& SnapGridFlowModuleDB

iy @ 3t i

Open

Compile Module Database

Module Bounds

The system now knows where to spawn the keys in the snap module
and what prefabs to spawn at those locations
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Spawn Locks

Locks are door prefab with locking support (optionally with different
visuals based on your art asset)

We’ll setup these locked door prefab in the snap connection

Keys are mapped in the Theme editor. Locks are mapped in the Snap
Connection prefab, since they deal with doors

Open Snap Connection Prefab Openthe Snap Connection prefab
that we created in the earlier section

Assets » Tutarial » Connections

ﬁ SnapCannection

OneWay

Setup Locked Door Similar to the way we’ve previously setup the
one-way door, we’ll setup two locked doors
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connections.md

Create an empty game object and rename it to LockRed. Place it along
side the Wall, Door and DoorOneWay game objects

Create Empty

Create Empty Child

3D Object 4
20 Object »
Effects ¥

= Hierarchy

+v =
. -, .
§P SnapConnection

FQ) SnapConnection

7 LockRed

Reset the transform
O Inspector

+ LockRed

We’ll now register this game object as a locked door with the marker
name as LockRed

Select the root Snap Connection object and inpect the properties
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= Hierarchy
+-

ﬁ SnapConnection

7 SnapConnection A

Snap Connection (Script)

onnection

Add a new entry to the Locked Doors array and set the marker name
to LockRed and assign the game object to it
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- e - .
® SnapConnection

Snap Connection (Script)

Snap Connection

Add Component

Repeat the same for the yellow lock. Set the marker name to Lock-
Yellow, create a new gameobject, reset the transform and assign
it
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ﬁ SnapConnection

Tag Untagged * Layer Default

Transform

Add Component

We used the names LockRed and LockYellow since this is what we
assigned in the Create Key/Lock node in the flow graph

Assign Lock prefabs Navigate to Assets\CodeRespawn\DungeonArchitect Samples\DemoBu.
and drop in DoorLargelLocked Red prefab as a child of LockRed
game object
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Open Prefab

. 9
DoorLargeLocked_Red

The alignment rules are the same like other doors. Reset the trans-
form of the red door prefab and it should align correctly (red line
should face outwards and the origin is in the bottom-center)
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Do the same for the yellow lock.

Hide the LockRed game object
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= Hierarchy 2 1 @ Inspector

+ -

- =~ ;
ap SnapConnection

napCannection

LockRed

Tag v Layer Default

e i

Add Component

Drop in the DoorLargeLocked Yellow prefab under the LockYellow

gameobject
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‘= Hierarchy

- - .
¥ SnapConnection

apConnection

Open Prefab

A
DoorLargeLocked_Yellow

m Demo_Them
m Demo_Them

Im Demo_Theme rLargelao

.
orLargelocked

The alignment rules are the same like other doors. Reset the trans-
form of the yellow door prefab and it should align correctly (red line
should face outwards and the origin is in the bottom-center)
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Hide the LockYellow game object
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= Hierarchy & & @ Inspector

+v

LockYellow
apConnection

Tag Default

Connection

e i !

Add Component

Make sure you hide the outermost LockRed and LockYellow
game objects and not the DoorLargeLocked Red and DoorlLarge-
Locked Yellow game objects

There is no difference between the DoorLargeLocked Red and Door-
LargeLocked Yellow prefabs other than the visuals and they are both
variants of the same parent prefab. The flow system will automati-
cally supply it with the valid key ids when the dungeon is built and a
common logic is used to check if we can open the door. More on this
later

Build dungeon

Open the scene where we previously set up our dungeon. Rebuild
the dungeon

Red lock guarding the main path:
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Yellow lock guarding the treasure room:
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Red Key:

Yellow Key:
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If your keys are shown half buried into the ground or below the ground,
adjust their offset from the theme editor, or move the placeable marker
game object up

Create Spawn Room

We’'re going to create a spawn room and place a marker there to
spawn our player prefab
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Spawn Room

Create a spawn room module like before and leave a few connection
points open

SPAWN
ROOM

In this example, we’ve created a 1x1x1 spawn room with a single
connection point

Create SpawnPoint Marker We want the theme engine to spawn
our player prefab in the spawn room. Create a placeable actor asset
named PM SpawnPoint

Folder

Create

C# Script
Show in Explorer Shader »

Open Testing >
Delete Playables >
Rename Assembly Definition

Copy Path Alt+Ctrl+C Assembly Definition Reference
TextMeshPro >

Open Scene Additive

Dungeon Architect > Dungeon Theme
View in Package Manager
Scene Snap Builder >
Import New Asset...
Post-processing Profile Grid Flow Builder ¥
Import Package > =
Prefab Variant Snap Grid Flow Builder b3 Snap Grid Flow Graph
Export Package... Modute Bound
- odule Bounds
Find References In Scene Audio Mixer Landscape 2
Select Deendonci Module Database
elect Dependencies
" Mterial Placesble Marker
Refresh Ctrl+R lensiFiTe Snap Connection )
Reimport Render Texture
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& L

+ fAssets » Tutorial » Place

ﬁ PM_Enemies

W PM_Keys
W9 PM_SpawnPaoint

Select the PM_SpawnPoint asset and inspect the properties.

Placeable Marker (Script)

Placeable Marker

Element O

Debug Visuals

¢ Add a marker named SpawnPoint in the Supported Markers
array

¢ Change the debug color to green

* Set the debug text to something descriptive, like Spawn Point

We set the marker name to SpawnPoint because this is what was
specified in the flow graph’s Create Main Path node

Main Path

Path Info
12
main
Create Grid  —®| Create Main Path | |— .  Crf
Alt

Marker Names

Aarker Mame

rName LevelG

Goal Nodes

Save and placeable marker prefab
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Add SpawnPoint Marker Open the Spawn Room module prefab
and drop this placeable marker asset somewhere appropriate

SPAWN
ROOM

Close the prefab and return to the scene

Add Player prefab Open the theme file we created previously.

Ltarial Themes

iy GameltemTheme
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Dungeon Theme

Grunt KeyYellow

!

Create a new Marker node and rename it to SpawnPoint

Add Game Object Node

Add Game Object Array Mode
Add Sprite Node

Add Marker Mode

Add Comment Node

Add Marker Emitter: Grunt
Add Marker Emitter: KeyRed

Add Marker Emitter: KeyVellow
Add Marker Emitter: SpawnPoint

SpawnPaint

Add a player prefab. We already have a player prefab setup
with some fps controls. Drop it from the samples folder Nav-
igate to Assets > CodeRespawn > DungeonArchitect Samples
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> DemoBuilder SnapGridFlow > Art > Prefabs > Player and
drag-drop SGFDemoPlayer on to the theme editor

i SGFDemoPla

We want the player prefab to spawn 1 unit high (since the placeable
markers was placed on the ground)

Game Object Node

ale

Attachment

ransform Rule

SpatialConstraint
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Save and close the theme editor

Register Spawn Module Open up the module database and regis-
ter this spawn room module

Tutorial > Modules

Element 4

le

Element

Asset Labels

Set the category name to SpawnRoom. We’ll use this category name
in the flow graph shortly, to force it to use our spawn room while
building the main path

Recompile the module database cache
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Module Bounds
Module Bounds A

Save the module database

Update Flow Graph Open up our flow graph editor and reassign
the Module database in the Editor Settings as before

eGrid | —®  CreateMainPath  —

Create KeyLock ¢ Create Key Lock i
Main Path Trossurooom | %

Select the Create Main Path node and inspect the properties

Create Grid =~ —#=| Create Main Path |——m  Create Pat
Alternate Pat
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Position Constraints

Paosition Constraint M | Nane

Snap Module Constraints
C y Constraint | Start End Node

Add an entry to Start Node Category Constraints and set it to Spawn -
Room.

This will make the flow editor choose the start room registered in the
module database with the specified category. As of now, we have only
one spawn room, feel free to register more modules with the same
name to have it randomly pick one spawn room

Hit build in the flow editor and make sure it generates a flow graph
correctly

Goal Room
Open up the Goal room prefab we created earlier

Tutorial » Modules

sFight

W

LleBounds

wduleDB
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We’ll create a placeable marker prefab that supports the marker name
LevelGoal. We’ll then use the theme engine to spawn our level goal
prefab (e.g. it could be an artifact that takes you to another dungeon)

This step is optional and you can skip this section if you don’t want to
spawn the Level Goal prefab from the theme engine. You may directly
place the level goal object inside the goal room module

Create LevelGoal Marker Create a Placeable Marker asset and
name it PM_LevelGoal
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Folder

Create > C# Seript
Show in Explorer Shader >
Open Testing >
Delete Playables >
Rename Assembly Definition
Copy Path Al Ctrl+ C Assembly Definition Reference
Open Scene Additive TextMeshPro >
Dungeon Architect > Dungeon Theme

View in Package Manager

Scene Snap Builder >
Import New Asset... ) )
Post-processing Profile Grid Flow Builder »
Import Package » ’ : .
Prefab Variant Snap Grid Flow Builder » Snap Grid Flow Graph
Export Package... Mot Boun
odule Bounds
Find References In Scene Audio Mixer Landscape >
S x Meodule Database
elect Dependencies ;
2 Ratera) Placeable Marker
Refresh CirleR Lens Flare Snap Connection
Reimport Render Texture

Tutarial > PlaceableMarkers
¥ PM_Enemies
W PM_
W9 PM_LevelGoal

awnP

Debug Visuals
[

Debug 1 Marker C

Change the Debug Text to something descriptive
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n Placeable Marker (Script)

able Marker

Element O

Debug Visuals
De (

We created a marker with the name LevelGoal since this is what we
specifed in the flow graph’s Create Main Path node

main

Create Grid = —#| Create MainPath | |——  Create
Alternat:

Result ~ #———  CreateKey Locl
Main Path

Add LevelGoal Marker Add the PM LevelGoal marker to the goal
module. Drag and drop it somwhere appropriate in your goal module
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@ Game

es | §§ Room |

orial /I

a

ording playmode

Since we’ve modified the markers in the module prefab, we’ll need
to recompile the module database cache

Open the module database and click Compile Module Database but-
ton
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Module Bounds

Module Bo

Tutarial » Themes

7 GameltemTheme

Create a new Marker node and rename it to LevelGoal

Add Game Object Mode

Add Game Object Array MNode
Add Sprite Node

Add Marker Node

Add Comment Node

Add Marker Emitter: Grunt
Add Marker Emitter: KeyRed
Add Marker Emitter: KeyYellow

Add Marker Ernitter: SpawnPoint
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LevelGoal

Add your level goal prefab here. We’ll use a simple cube for this
example that will represent the final boss

Game Object Node

i Cube_Red

LevelGoal

Attachment

Probability

Consume On Attach

Build dungeon

Open the scene where we previously set up our dungeon. Rebuild
the dungeon

You should see the spawn room, and a PlayerStart actor spawned
at the correct place
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You should be able to play your game and move around with the player
prefab

Level Goal prefab:
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## Finalize Graph

The final node of your flow graph design should always be the Fi-
nalize Graph node. This node does the following: * Strategically
promote some doors to one-way doors. This is done to keep the player
from bypassing locked doors by entering from another nearby door.
This may also be done to keep the player from entering another path
from the opposite direction. It will always create a playable level *
Remove unused links from the layout graph

Add Finalize Node

Open the flow graph we designed earlier and add a Finalize Graph
node
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Layout Graph Create Grid
Create Main Path

Add Comment Mode

Create Path
Spawn ltems
Create Key Lock
Finalize Grap! *

Link it before the Result node as shown below

Create Grid — | Create MainPath | ——  Create Path
Alternate Path

Result <«——| | Finalize Graph | |@—  CreateKeyLock
Main Path

Build the graph and have a look at the layout graph
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The orange double head arrows indicate one-way doors

We have already specified a one-way door asset in the snap connection
prefab previously
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This one-way door prefab will be used in those locations

Build the dungeon

Open the scene where we previously set up our dungeon. Rebuild
the dungeon

You should see one-way doors spawn where needed
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We have now created a fully playable level and this wraps up our
dungeon flow design. Feel free to add more path or play around with
your own design

In the next section, we’ll look at how to set up gameplay where we
will build a random dungeon at runtime, move the player to the spawn
room and have the player character (first person, third person etc)
move around the map, pick up keys, open locked doors and more

Setup Gameplay

We want to be able to open locked doors after we’ve picked up the
keys. For this to happen, we need to implement a few things: * Pick up
the keys when we touch them and place it in our inventory * When we
get close to a locked door blueprint, check the keys in our inventory
and find out if any one of them can open it * A Ul to show the keys in
our inventory
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Player Inventory

You may create your inventory in any way you like. A simple inventory
is implemented for the sample character

Check the Inventory classin this path: Assets\CodeRespawn\DungeonArchitect Samples\Dem

It contains four inventory slots. Each inventory slot contains an item
id and a preview texture to show the item in the Ul

There’s also a PickableItemclassin this path: Assets\CodeRespawn\DungeonArchitect Sampl

Pickable Item

If there’s an object that you’d the player to pick (e.g. keys), add
a PickableItem component to it. Whenever a gameobject with an
inventory touches this object (e.g. a player), it would add the item id
to the next free slot of the inventory and destroy the pickable object

This is how the keys get added to the inventory and disappear when
you touch them

Pickable items have an icon texture that you specify in your prefabs.
This texture is added to the inventory slot so it can be shown in the
inventory Ul

Locked Doors

You are free to implement this in any way you like. A sample is pro-
vided in LockedDoor. cs file here: Assets\CodeRespawn\DungeonArchitect Samples\DemoBuil

When Dungeon Architect spawns the Key and Locked Door prefabs, it
will automatically insert a FlowItemMetadataComponent to it with the
item id. This component will also contain referenced item ids. A key
item will reference the lock item and vice versa. So if you are reading
a locked door item metadata, the reference item ids will contain a list
of key ids that can open this lock

Key Metadata:
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tadata Component (Seript)

Lock Metadata:

Notice how the key references the lock id and the lock references the
key id

This component was added automatically by the flow framework when
the dungeon was built

When ever we pick a key, the key item ids are added to our inventory.
When a player enters the trigger volume of a locked door, we simply
check if the inventory contiains any of the key ids that this lock can
open

bool CanOpenDoor(Collider other)
{
var inventory = other.gameObject.GetComponentInChildren<Inventory>();
if (inventory != null)
{
// Check if any of the valid keys are present in the inventory of the cc
foreach (var validKey in validKeys)

301



if (inventory.ContainsItem(validKey))

{
}

return true;

}
}

return false;

Grid Builder

Introduction
Grid Builder

The Grid Builder generates a dungeon by scattering rooms across
the map and connecting them with corridors. The builder supports
height variations (stairs)

We’ve used this dungeon builder in the previous section Create your
first Dungeon and Design your first Theme

In the following sections, we’ll explore more about this builder

Properties

Continuing on the scene created in the section Design your first
Theme, open the scene and select the DungeonGrid game object and
inspect the properties
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¥ «  Grid Dungeon Config (Script) @ = #
Core Config
Seed [i] @
Num Cells 100
Grid Cell Size X4 Y2 Z|4
Cell Dimensions
Min Cell Size 3
Max Cell Size 5
Room Area Threshold 20
Room Aspect Delta 0.4
Corrider Width 2

Height Variations

Height Variation Probability0.2
Max Allowed Stair Height 1
Stair Connection Tolleranc| 7
Spanning Tree Loop Probal0.15

Misc

Mode 2D -
Normal Mean 0
Normal Std 0.3
Initial Roomn Radius 20
Door Proximity Steps 3

Experimental

Use Fast Cell Distribution ||

Cell Distribution Width 20

Cell Distribution Length 30

Wall Layout Type | Walls As Edges al

Change the Seed parameter to build a different dungeon layout
Set the Grid Cell Size parameter according to your moduler
art asset. If the ground mesh is 4x4 and the stair mesh height is
2, set thisto (4, 2, 4)

The dungeon creation method first creates a number of cells
(defined by NumCells) and spreads them across the scene.

The size of these cells is define by the parameters Min Cell
Size and Max Cell Size

Some of these cells will be promoted to Rooms and the rest
will be promoted to Corridors. If the cell area is large enough
(parameter Room Area Threshold), that cell is promoted to a
Room, otherwise a Corridor

The rooms are connected together with corridors

Control how much height variation is allowed with Height Vari-
ation Probability

A new Stair will not be created between two tiles if there’s
another stair nearby that if traversed, takes N steps to reach this
cell. This value is controlled by Stair Connection Tollerance.
Bump this number up if you want fewer stairs
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¢ Maximum allowed stair: Determine how high a stair tile can get.
If set to one, the builder will create stairs that go only one level
up

* Both Rooms and Corridors have a Ground marker. Rooms are
surrounded by Wall markers while the corridors are surrounded
by Fence marker

Platform Volume

Platform Volumes let you control the placement of the rooms or cor-
ridors. You do this dropping in a platform volume on to the scene
and resizing / positioning it on the scene and you room will be built
around it.

Navigate to Asset/DungeonArchitect/Prefabs and drag drop the
PlatformVolume prefab on to the scene
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=) Tutorial_D1A*

B3 Project

4 Aszsets » Dungeonfrchitect > Prefa

Prefabs

Flatformyelume

Select the PlatformVolume game object and set the Dungeon refer-
ence
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= Hierarchy ® Inspector

| cr!::!Q?|T:::llia|_nln* = - ¥ PlatformVolume | [ static =
| Main Camera Tag Layer

» iy DungeonGrid » Prefab | ©pen | Select | | Dverrides_ - |

| Directional Light ¥ .~ Transform o

| Dungeon Items Position .'(|l:l |T|l'.l |Z |l:l |

ation X0 ¥ 0 |20 |

¥ 10 1 |z [10 |

¥ o Plaﬁwume (Script) <

Script FlatformVolume (2]

I Dungeon |~ DungeonGrid (Dungeo @
Mode 2D -

Cell Type [ Room =

[ Rebuild Dungeon ]

’ &dd Component l

Click the button Rebuild Dungeon

Move the Platform Volume and scale it to control the position and
size of your room. You can have multiple platform volumes in the
scene. Check the samples in the Launch Pad for more examples
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Theme Override Volume

Theme Override Volumes let you apply another theme on certain
portions of your dungeons that are covered by this volume. These
are useful for adding variations to your dungeons.

Navigate to Asset/DungeonArchitect/Prefabs and drag drop the
ThemeOverrideVolume prefab on to the scene
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=) Tutorial_D1A*

3 Project

Assets » DungeonArchitect > P

Prefabs

Theme

Move and scale it to cover a certain portion of the dungeon
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Select the theme override volume you just dropped and inspect the
properties and assign the DungeonGrid reference

¥ |ou Theme Override Volume (Script) a

Script ThemeOverrideVolume @
I Dungeon | - DungeonGrid (Dungeon) | ©

Mode 2D -

Override Theme |None (Graph) | @

Use Base Theme For[_|
[ Rebuild Dungeon ]

Navigate to Assets/DungeonArchitect Samples/Demo Theme SimpleShapes/Themes
and assign the theme Theme Basic White to the Theme Override
Volume
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Create 7| (2 ) *
| create -| > E1E | - ¥ [ThemeoOverrideVolume | O static +
Y{}Fivorlte! n Assets » DungeonArchitect |
@A” Materials .| BasicEhapeDungeon ¢) Layer [Defaule |
O All Models il Theme_Basic_Blue | Select | [oOveriides il
CLall Prefabs L) Theme_Basic_Green || ¥.~  Transform i
(©L Al Seripts .| Theme_Basic_orange | Position x[46.6 |¥[0 z[59.22
.| Theme_Basic_Pink Rotation X0 Yo Zo
Asset i
¥ G5 Assets : J Theme_Basic_Purple Scale X 61.607 ¥ 13.814) 2 57.411
» &3 DungeonArchitect | Theme_Basic_Red
» 5 DungeonArchitect_LaunchPad LU il | T o+ Theme Override Volume (Scrip a3
¥ @SDungeonArchitect Samples ~ LJ Theme_Basic_vellow | ThemeOverrideVolume | @

» &5 Demo_LandscapeTransform
» &5 Demo_SpatialConstraints
» G5 Demo_Theme_Candy

» &5 Demo_Theme_OutdoorCliffs
¥ G Demo_Theme_SimpleShape

b+ 55 Prefabs
> & Scenes

» &5 DemoBuilder_CircularCity
» & DemoBuilder_FloorPlanner
» &5 DemoBuilder_GridFlow

» &5 DemoBuilder_GridFlow2D

» &5 DemoBuilder_InfinityCaves
» G5 DemoBuilder_Isaac

» &5 DemoBuilder_Mario

& DemoBuilder_Maze

» G5 DemoBuilder_SimpleCity

» &5 DemoBuilder_Snap

» &5 DemoBuilder_Snap_SideSer

Override Theme
Use Base Theme For|_|

|~ DungeonGrid (Dungeon| @

F%Theme_ﬂasic_white (G‘ +

[

Rebuild Dungeon ]

Add Component ]

Click Rebuild Dungeon

Paint Mode

You can paint your own dungeon layout on top of the procedural
dungeon

Select the DungeonGrid prefab and expand it. Select the PaintMode

game object. This will activate the Paint Mode
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= Hierarcny

| Create *l
v €{ Tutorial_0D1A*

| 'Main Camera

¥ o DungeonGrid

| Directional Light
» _ Dungeon Items

Left click and drag to draw dungeon cells. Shift + Left click
to delete cells. Scroll wheel to move the cursor up/down

[

Advanced Theming

Selection Rule
Overview

We use the probability parameter to decide if we want to select and
insert a certain object into the scene. If you need more control, you
could write your own selection rules scripts
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9 in

Realtime Update 6)

Game Object Node

API

Create a C# script that inherits from DungeonArchitect.SelectorRule
Override the following method
bool CanSelect(PropSocket socket, Matrix4x4 propTransform, DungeonModel model, S

Parameter | Description socket | The information about the marker
propTransform | The final transform of the object that will be inserted
model | The dungeon model object. You’ll want to cast it to the
approprirate model (e.g. GridDungeonModel and read the layout info if
needed) random | The random stream. If you rely on any randomness,
this object should be used to create consistent results in the dungeon

Example

In this example the towers are too crowded and close to each other.
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Game Object Node

Template [None (Game Object) le
Is Static
Offset
Position  X: [0 ¥: [5.5 z: o
Rotation  X: [0 ¥ [0 lz:[o
Scale X1 Y1 Jz:[1
Attachment
Probability 1
Consume On Attach L
Rules
[ Selection Rule I AlternateSelectionRule | &

[[] Transform Rule None (MonoScript) lo

using UnityEngine;
using System.Collections;
using DungeonArchitect;

public class AlternateSelectionRule : SelectorRule {
public override bool CanSelect(PropSocket socket, Matrix4x4 propTransform,
return (socket.gridPosition.x + socket.gridPosition.z) % 2 == 0;

}

Transform Rule

Dungeon Architect lets you specify offsets to your visual nodes to
move/scale/rotate them from their relative marker locations.
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Game Object Node

However, if you want a more dynamic way of applying offsets (based
on scripts), you can do so with a Transform Rule. This can be very
useful for adding variations to your levels for certain props

You can create new transform rules by implementing the Transforma-
tionRule class under the DungeonArchitect namespace

using UnityEngine;

using System.Collections;
using DungeonArchitect;

using DungeonArchitect.Utils;

public class RandomRotYTransformRule : TransformationRule {

public override void GetTransform(PropSocket socket, DungeonModel model, Mat
base.GetTransform(socket, model, propTransform, random, out outPosition,

// Your transform logic here.
// Update the outPosition, outRotation or outScale if necessary

}
Attach this script to the theme node
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Realtime Upd

Example #1

In this example, the cliff rocks are facing the same direction and do
not look organic

! Y
e
o
‘;i/ :\\‘\-\{“’ \
/

After applying the transform script to the rock node, it looks much
better
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Game Object Node

Template None (Came Object) Q

RandomCliffRack Is Static )

Offset
Position  X: 0 ¥: |0 Z: |0
Rotation  X:
Scale X:

P

=)
<
=)
N
o

=
=
=
™~
-

Attachment

Probability 1

Consume On Attach [

Rules

[] Selection Rule & None (Mono ©
[ Transform Rule [ RandomCliff @

using UnityEngine;

using System.Collections;
using DungeonArchitect;

using DungeonArchitect.Utils;

public class RandomCliffTransformRule : TransformationRule {
public override void GetTransform(PropSocket socket, DungeonModel model, Mat
base.GetTransform(socket, model, propTransform, random, out outPosition,

// Randomly rotate along the Y-axis

var angle = random.NextFloat() * 360;
var rotation = Quaternion.Euler(0, angle, 0);
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outRotation = rotation;
// Slightly translate the node

var variation = new Vector3(0.25f, -1, 0.25f);
outPosition = Vector3.Scale (random.OnUnitSphere(), variation);

Example #2

In this example a small random rotation is applied to ground tiles.
This might be useful while creating ruins when laying down broken
tile meshes

using UnityEngine;

using System.Collections;
using DungeonArchitect;

using DungeonArchitect.Utils;

public class BrokenTilesTransformRule : TransformationRule {
public float maxAngle = 5;

public override void GetTransform(PropSocket socket, DungeonModel model, Mat
base.GetTransform(socket, model, propTransform, random, out outPosition,

var rx = random.Range(-maxAngle, maxAngle);
var ry random.Range (-maxAngle, maxAngle);
var rz random.Range (-maxAngle, maxAngle);
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outRotation = Quaternion.Euler(rx, ry, rz);

Example #3

In this example, the outer trees are spawned in the same height as
the dungeon layout

We have a terrain that Dungeon Architect modifies and its steepness
value is controlled by the user using a curve.

So, we would like to clamp this tree’s base on the dynamic terrain.

- = = — : . ey e e L | 72 e
Q s = [l
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This is done by finding the height of the terrain at that location,
and creating an offset such that the tree would move up or down to
properly clamp on it

using UnityEngine;

using System.Collections;
using DungeonArchitect;

using DungeonArchitect.Utils;

public class ClampToTerrainTransformRule : TransformationRule {

public override void GetTransform(PropSocket socket, DungeonModel model, Mat
base.GetTransform(socket, model, propTransform, random, out outPosition,

var terrain = Terrain.activeTerrain;
if (terrain == null) {
return;

}

var position = Matrix.GetTranslation(ref propTransform);
var currentY = position.y;
var targetY = LandscapeDataRasterizer.GetHeight(terrain, position.x, pos

outPosition.y = targetY - currenty;

Item Spawn Listener

Item Spawn Listeners get notified of every game object that is
spawned by the theme engine. This allows you to modify the spawned
objects and perform post processing on them (e.g. set metadata, add
/ remove extra components etc)

You’'ll need to inherit from DungeonItemSpawnListener and imple-
ment the following function

void SetMetadata(GameObject dungeonItem, DungeonNodeSpawnData spawnData)
Then add this script to the dungeon game object

using DungeonArchitect;

using UnityEngine;

public class FlowItemMetadataHandler : DungeonItemSpawnListener

{

public override void SetMetadata(GameObject dungeonItem, DungeonNodeSpawnDat
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if (dungeonItem != null)

{
}

dungeonItem.AddComponent<...>();

Advanced Dungeons

Landscape Transformer

Dungeon Architect supports non-destructive landscape transforma-
tions around the generated dungeon

To see this in action, clone the Landscape transformer sample from
the launchpad

Builder Templates

Samples

Flow Graph Templ
Theme Templates
Documentation

Support

You can build your dungeons on top of an existing landscape that has
painted textures and foliage
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The heightfield, paint and foliage around the dungeon would be mod-
ified

This is non destructive, so when you destroy your dungeon, the origi-
nal landscape data (height, paint, foliage etc) in that area is restored

Right now, the Grid Builder and City builder support landscape trans-
formations
Setup Landscape Transformer

To add support for landscape transformations, perform the following,

1. Move your dungeon game object to the location where you’d like
to build your dungeon
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2. Add the LandscapeTransformerGrid or the LandscapeTrans-
formerCity component to your dungeon game object, depending
on the builder

Add Component
o landscape trans
Search
ﬂL:.ﬂ D ansformer Base
Lar
ﬂ Landscape Tranarr}rr*_r Grid

Mew script
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E; Landscape Transformer Grid (Script)

Terrain MNeone (Terrain)

Lar

3. This script requires the terrain game object reference so it can
modify it.

ﬁ Landscape Transformer Grid (Script)

Terrain None (Terrain)

[ pe R ion Cac Neone (Dungeon Lan

Textures
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Open

ungeonitems Transform

# Dungeon (Script)

1 Themes

Build Dungeon

Destroy Dungeon

i

Grid Dungeon Config (Script)

#

/ Durgeon Runtime Mavigation (Script)

r;

i

Grid Dungeon Builder (Script)

#

Grid Dungeon Model (Script)

Pooled Dungeon Scene Provider (Script)

i

Spatial Constraint Processor Grid 3D (Script)

#

Grid Item Metadata Handler (Script)

i

Grid Dungeon Qu (Script)

P09 DODO0OQODOO O
T+

#

Landscape Transformer Grid (Script)

4. To support non-destructive landscape modification, Dungeon
Architect needs to save the state of the landscape in the area
where it modifies it, so that it can restore it later on (when the
dungeon is destroyed or modified)

Create a landscape restoration cache asset
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Create > Folder

Show in Explorer

C# Script
= Shader
Delete e
Gz Playables
Copy Path AltCtikeC A —
Open Scene Additive Assembly Definition Reference
View in Package Manager ==
Dungeon Architect
Import New Asset...
Import Package > S
m——— Post-processing Profile
Find References In Scene Pt
Select Dependencies Audio Mixer
Refresh CtrleR Material

hiEr i

LF » Lanscape

Dungeon Theme

Snap Builder >
Grid Flow Builder 5
Snap Grid Flow Builder 5

Landscape e Restoration Cache

I'.i:i'}Dungen1L:—mdsr:.apeﬁesmratim‘u:ar:.he

5. Assign this to the Lanscape Transformer script
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Grid Dungeon Query (Script)

ﬁ Landscape Transformer Grid (Script)

Terrain = Terrain (Terrain)

yration 1| 5= 0Du

m Blur Threst

Add Component

LandscapeDemm

torationCache

. Assign the Elevation curves so we have a smooth transition from
the existing terrain to the dungeon

:::warning Important Unity will leave this blank by default and
you need to assign it some value for it to work :::

Layout Level O
Smoathing Distance

ym Elevation Curve
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Click on blank area to open up the curve editor. Choose one of
the values highlighted below

Curve n

Close the curve editor
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Do the same for Corridor Elevation Curves

Corridor Elevation Cury :

Room Elevation Curve

7. Build the dungeon

Destroy the dungeon to restore the terrain back
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Setup Paint Support

You may paint your terrain around the rooms, corridor and cliffs by
applying your existing terrain layers. Since you already have a terrain,
you would have setup terrain layers to paint your terrain. If not, find
more info about Terrain Layers here. We’ll paint the rooms with a
certain terrain layer

E Landscape Transformer Grih @ 3t

Brrain == 1&rrain (Terrain)

Corridor Blur Threst

Room Blur Threshold

Create a new Texture entry and add an existing Terrain Layer

330


https://docs.unity3d.com/Manual/class-TerrainLayer.html

Room

Maone (Terrain Layer)

Mone
B TerainLayer Dirt
. TerrainL ;
. TerrainL

errainlz
rrain L

Element 0

Texture Type  Room

errain Layer B TerrainLayer_Dirt

Set the Texture Type to Room or Corridor.

Cliff Texture Type is not supported for the time being and should
not be used

Set the Road Blur Distance to 1
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UL Ley

Smooathing Distance

d Blur Distance
Carridor Blur Thresho €
Rooam Blur Thres

Now build your dungeon

Add a corridor texture
Element 1

exture Type  Corridor

errain Layer R TerrainLaye
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